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Contact Information
TEAM

CONTACT INFORMATION

Sales

1.866.270.1449

General Support

http://www.dameware.com/customers.aspx

Technical Support

Submit a ticket: http://www.dameware.com/technical-support.aspx

Customer Service

Submit a ticket: http://www.dameware.com/customers/customerservice.aspx

User Forums

Thwack

DameWare only provides technical support by email. If you need technical support, please open a ticket
using a link provided in the table.

End-of- Life Policy
In order to continue to drive innovation and new functionality into our products, SolarWinds must transition
customers from legacy versions of software to our current versions. Please review the following support
schedule:
l

l

04/28/2015: End-of-Life (EoL) – SolarWinds will no longer provide technical support for SolarWinds
DameWare v8.0.1 or older.
05/06/2014: End-of-Life announcement (EoL) – Customers on DameWare v7.4 or older should begin
transition to DameWare 11.0 or DameWare 12.0.

l

12/12/2012: End-of-Life (EoL) – SolarWinds will no longer provide technical support for SolarWinds
DameWare v6.9 or older.
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Introduction
About DameWare Remote Support
DameWare Remote Support is an enterprise system management application for
computers running the Windows platform. In short, Remote Support helps you manage
your entire Windows based network from a single Explorer-style interface. The following
is a summary of the major features in Remote Support:
l

l

l

l

Manage computers running a variety of Windows operating systems (32-bit and 64bit), including:
l

Windows Vista

l

Windows Server 2008 (including R2)

l

Windows 7

l

Windows Server 2012 (including R2)

l

Windows 8

l

Windows 8.1

l

Windows 10

l

Windows Server 2016

Access Microsoft Management Console (MMC) functionality and more in a
centralized remote management interface.
Access standard and enhanced Windows and Windows Server utilities for superior
performance, added functionality, and ease of use.
Use standard shell property pages and shell context menus.
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l

l

l

l

l

l

l

Retrieve, search, and filter Microsoft Active Directory (AD) Objects & attributes in a
powerful Active Directory Object Browser.
Manage AD objects such as Organizational Units (OU), Containers, Users, Groups,
Contacts, Computers, and Shares
Manage non-Microsoft AD attributes, such as photos, logos, and employee IDs.
Manage non-AD Microsoft Windows network implementations with a dynamic
"Microsoft Windows Network" Browser tree view.
Add domain controllers, servers, workstations, and non-browsable computers by
machine name or IP address to the network browser tree view on demand.
Use DameWare Mini Remote Control to interactively manage and troubleshoot
remote computers.
Use DameWare Exporter to quickly extract information from remote computers.

System requirements
Hardware
Install DameWare Remote Support on a computer that meets the following minimum
requirements:
l

1 GHz CPU

l

20 MB RAM

l

150 MB available hard drive space

Operating system
Install Remote Support on a computer running any of the following operating systems:
l

Windows Vista

l

Windows Server 2008 (including R2)

l

Windows 7

l

Windows Server 2012 (including R2)

l

Windows 8

l

Windows 8.1

l

Windows 10

l

Windows Server 2016
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The APIs used by Remote Support also require the user to have the ability to
authenticate to this remote machine over the network. In other words, it may require the
Server Service, the NetLogon Service (Domain environments), and possibly the Remote
Registry Service as well. Remote Support requires the Remote Registry Service for the
following functions because they require access to the Registry.
l

Event Log View

l

Properties View

l

Processes View

l

Registry View

l

Services View

l

Software View

The Remote Registry Service is turned off by default in Windows Vista and later.

Com Control
The following informational message will be displayed whenever Remote Support is
executed on systems that do not have version 4.71 or later of the Microsoft
COMCTL32.DLL file:
This version of Remote Support requires a newer version of COMCTL32.DLL
(Version 4.71 or later) than what is installed on this machine (Version x.xx). A
newer version of this DLL can be obtained from Microsoft and is shipped with NT
SP4 and IE 4.x or higher.
Where x.xx is the version of COMCTL32.DLL on the computer receiving this message.
Remote Support still functions with older versions of Com Control. However, it is
recommended that you update COMCTL32.DLL to a later version for best results. This file
is not re-distributable by third party software developers, but you can download it from
Microsoft and install it.

Licensing and activation
Licensing
DameWare standalone software is licensed per user, and each license allows you to
install on 3 computers. The Remote Support Client Agent Service is not licensed and
there are no additional fees for installing the service on remote systems. For example, if
you have 10 computers running Remote Support and you use Remote Support to
manage 10,000 remote systems, you only need to license the 10 Remote Support
computers to maintain compliance with the SolarWinds End User License Agreement
(EULA). To purchase licenses, visit www.dameware.com.
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The DameWare centralized version is licensed per user, but the licensing and activation
occur on the DameWare Central Server using the centralized license key. The centralized
license includes a licensed user count, and each authorized DameWare user reduces the
number of available user licenses. For example, if you purchased a 10 user license, you
can install and use Remote Support or Mini Remote Control from any computer so long
as you can logon to the DameWare Central Server and do not exceed 10 users. The Mini
Remote Control Client Agent Service in the centralized version is not licensed and there
are no additional fees for installing it.
To comply with the SolarWinds EULA, you cannot activate both standalone and
centralized software at the same time.

Activation
After installing 12.0.4, you are prompted to enter the licensing information for your
product. If you choose to start with the 14-day evaluation, you can access the Licensing
Information options by opening Start > All Programs > SolarWinds > DameWare
Remote Support 12.0.4 > Enter License Information on the computer you want to
license.
Versions 10.0 and later of DameWare uses a new licensing method that allows you
to keep the same license key when you upgrade. Version 9 license keys can also
use this method. For more information, see knowledge base article 400135.

To evaluate the software without a license:
Click Continue Evaluation.

To license the software on a computer with Internet access:
1. Click Enter Licensing Information.
2. Select I have internet access and an activation key.
3. Click the http://www.solarwinds.com/customerportal link to access the customer
portal on the SolarWinds web site.
4. Log on to the portal using your SolarWinds customer ID and password.
5. Click License Management on the left navigation bar.
6. Navigate to your product, choose an activation key from the Unregistered
Licenses section, and then copy the activation key.
7. If you cannot find an activation key in the Unregistered Licenses section, contact
DameWare customer service: http://www.dameware.com/customers/customerservice.aspx.
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8. Return to the Activate Remote Support window, and then enter the activation key
in the Activation Key field.
9. If you access Internet web sites through a proxy server, click I access the
internet through a proxy server, and enter its proxy address and port.
If you access the Internet through an authenticated proxy server, use the
procedure for activating without Internet access instead.

10. Click Next.
11. Enter your email address and other registration information, and then click Next.
To license the software on a computer without Internet access:
1. Click Enter Licensing Information
2. Select This server does not have internet access, and then click Next.
3. Click Copy Unique Machine ID.
4. Paste the copied data into a text editor document.
5. Transfer the document to a computer with Internet access.
6. On the computer with Internet access, complete the following steps:
a. Browse to
http://www.solarwinds.com/customerportal/licensemanagement.aspx, and
then log on to the portal with your SolarWinds customer ID and password.
b. Navigate to your product, and then click Manually Register License.
c. If the Manually Register License option is not available for your product,
contact DameWare customer service:
http://www.dameware.com/customers/customer-service.aspx.
d. Provide the Machine ID from Step 5, and then download your license key file.
7. Transfer the license key file to the Remote Support computer.
8. Return to the Activate Remote Support window, browse to the license key file, and
then click Next.
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Connecting to the Central Server
Connect to the Central Server
When you have installed DameWare Remote Support or DameWare Mini Remote Control
in centralized mode, you must first connect to the DameWare Central Server. This allows
you to login and use your personal host list or a global host list.
You can log in using either Windows authentication, if your Active Directory account has
the appropriate permissions, or your DameWare Central Server credentials.
You need the following information to connect to the DameWare Central Server:
l

DameWare Central Server user name and password, if using DameWare
authentication

l

DameWare Central Server IP address or host name

l

Service Port Number

The DameWare Central Server user name and password are independent of your other
credentials and are established by your DameWare Central Server administrator. The
Central Server administrator must also provide the DameWare Central Server IP address
or host name and the port number to use.
If this is your first time connecting, you can change your password after you logon
by navigating to File > Change Password.
To connect to the DameWare Central Server:

1. On the Login details tab, either:
l

Select Windows authentication, to use the Active Directory credentials with
which you logged into your machine and domain.

Or:
l

Select DameWare authentication, and enter your DameWare Central
Server credentials.
If you have forgotten your password, contact your DameWare Central
Server administrator to have it reset.

2. If you do not want to enter your credentials each time, select Remember the last
connection settings.
3. Select the Advanced settings tab.
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4. The default connection settings are displayed. To change these, enter the
DameWare Central Server IP address or host name and port number.
The default port is 6133.

5. If you change the settings and want these to be used in future, click Save as default.
When you click Reset to default, the last saved server information
populates the fields.

6. If you do not want to display this dialog in future, select the Don't show again
checkbox.
The dialog may appear briefly but does not require input.

7. Click Connect to server.
To restore the Central Server Login Dialog:
If you have chosen not to show the Central Server Login Dialog and later decide to
restore it:

1. On the Mini Remote Control main menu bar, go to View > Local Global Options.
2. Select the Additional Options tab if not displayed, and deselect the Central
Server Login Window checkbox.
3. Click OK.

Troubleshoot Your Central Server connection
Before you can logon to the DameWare Central Server and use DameWare Remote
Support or DameWare Mini Remote Control in centralized mode, the DameWare Central
Server administrator must create an account for you to use and provide you with the
Central Server information.
To logon, you will need the following information:
l

l

The DameWare Central Server and/or DameWare Mobile Gateway IP address or
host name, if you are using DameWare authorization
The DameWare service port number (default is 6133)

You can connect using either Windows Authentication or Dameware Authentication.
l

Windows Authentication uses the credentials you used to log into your machine. If
this account has not been assigned the administrator privileges, you cannot log on
to the Administrator Console.
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l

DameWare Authentication refers to DameWare specific user accounts that are
independent of your other credentials. The default administrator name is admin
and the default password is admin. If your DameWare user account does not have
administrator privileges, you cannot log on to the Administrator Console.
Use an IPv4 address or a hostname. If you need to use an IPv6 address, you
must add the address and host name to your host file. See KB 400151 for
more information.

If you cannot logon to the Central Server and your DameWare user name and Central Server
information are correct, you may have exceeded the number of licensed users or your
account may be disabled. Contact your DameWare Central Server administrator to
resolve this issue.
Each time you logon to DameWare Central Server from Remote Support or Mini Remote
Control in centralized mode, you create a Central Server session. You can create multiple
sessions from a single computer, but you cannot create sessions from different
computers. If you open a second session from another Remote Support or Mini Remote
Control console located on a different computer, your previous Central Server sessions are
closed. Other reasons for your session to close include a Central Server administrator
closing it or because you were idle for too long.

Multiple Document Interface
DameWare Remote Support is written with Multiple Document Interface (MDI) and is
divided into two separate window panes. The left pane contains the Network Browser
explorer tree view and Information View. The right pane contains a tabbed MDI with a
separate tab for the tasks and views you open.
Each Remote Support view contains a mini-toolbar to access custom properties. Each of
these views have a similar look and feel. To customize the layout of a single view, do any
of the following:
l

Resize the columns: Double-click any column separator.

l

Move columns: Drag and drop column headers.

l

Sort column data: Click the column header once to sort in ascending order and
twice to sort in descending order.

You can also customize how each view behaves by setting different thread priorities for
each task/view.
To specify the thread priority for Remote Support views:

1. From the View menu, select Properties.
2. Click the Threads tab.
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3. Select a thread priority for each of the views from their respective menus.
4. Click OK.
To stop a thread while it is loading:
Click

in the main toolbar.

To refresh a view after it has loaded:

Click

in the main toolbar.

Keyboard shortcuts
Use the following keyboard shortcuts to navigate the Remote Support MDI:
l

Ctrl+F4: Close the active tab

l

Ctrl+F6: Open the next tab

l

F5: Refresh content
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DRS's Network Browser Pane
Network Browser pane
DameWare Remote Support establishes focus on the Network Browser tree view on
application start up. The following sections address how to navigate and read the items
in this pane.

Keyboard shortcuts
The following keyboard keys and key combinations are supported throughout the
Remote Support applications.
SHORTCUT

FUNCTION

Enter

Execute the selection

F9

Switch between the Network Browser pane and MDI windows

Right/Left arrow
keys

Expand and collapse items in the network browser tree view

Up/Down arrow
keys

Navigate up and down the Network Browser tree view

Ctrl+F6

Switch between all open MDI windows

Ctrl+F4

Close the active MDI tab

Network Browser icons
Represents the root level of the Active Directory
Browser list.
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Represents the root level of the AD Browser list, when
AD support is disabled.
Represents the root level of the Windows Network
Browser list.
Represents the root level of the Favorite Domains list.
Represents the root level of the Favorite Machines
(formerly Non-Browsable) Machines list.
Represents an Active Directory container, or a folder
under the Favorite Machines list.
Represents an Active Directory OU or Container.
Represents a AD Domain Controller or Server running
Microsoft Exchange 2000 or greater.
Represents the root of the Exchange System objects
(only shown when Advanced Features are displayed).
Represents an AD/Exchange Public Folder.
Represents the AD Domain Policy.
Represents the AD File Replication Service settings.
Represents the RCP Services container.
Represents a Domain in the browser list and also a
Primary Domain Controller in the Server list.
Represents a Primary Domain Controller in the browser
list that is not confirmed active.
Represents a domain that contains at least one
Windows Terminal Server.
Represents a Primary Domain Controller that is running
Windows Terminal Server.
Represents a Primary Domain Controller that is running
Windows Terminal Server but is not confirmed active.
Represents a Backup Domain Controller in the browser
list.
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Represents a Backup Domain Controller in the browser
list that is not confirmed active.
Represents a Backup Domain Controller that is running
Windows Terminal Server.
Represents a Backup Domain Controller that is running
Windows Terminal Server but is not confirmed active.
Represents the current Network Browser process is
working.
Represents no Primary Domain Controller is found for
this domain.
Represents Windows Vista workstations in the browser
list.
Represents machines that are currently not available or
have not been checked on the current network
connection(s).
Represents machines that have been disabled in the
browser list, or the root of the Computers list.
Represents machines that are Windows for
Workgroups.
Machines identified with this icon do not have
expanded views in the Network Browser tree
view.

Icon status in the Network Browser pane
DameWare Remote Support does not directly contact systems in the Microsoft Windows
Network list in the Network Browser pane to update their status icons. This is because
there should already be enough information available directly within Microsoft's
Windows Network Browser itself. So the icons & tool tips for systems listed in the
Network Browser pane, as well as the categories they are placed into, only reflects what
information is available directly within Microsoft's Windows Network Browser. Remote
Support retrieves this information by asking your local system for its Microsoft Windows
Network Browser, and then displays the information according to the OS returns. Remote
Support does not modify this information in any way.

- 12 -

Chapter 2
With regard to Computers, Remote Support provides a list of all Domain Members
directly from the Security Account Manager (SAM) database. The database could,
however, list systems that are not currently online or do not even exist. In the latter case,
non-existent systems will continue to show up until you manually delete the related
computer account on the Domain.
On the other hand, Remote Support does attempt to directly contact the systems in the
Active Directory and Favorite Machines lists to update their icons. To do this, Remote
Support requests a NULL connection to the remote system, and then asks the OS to
execute standard Microsoft Windows Network management API calls to retrieve the
necessary information. The Microsoft Windows API call that Remote Support uses to
contact these remote machines is called NetServerGetInfo. Remote Support changes
the icon and tooltip accordingly.

Icon colors
Red (or Blue with the Red "Prohibited" sign) icons represent remote systems that have
not been contacted yet, or could not be contacted. See System requirements.
Green icons represent remote systems running Terminal Services.
If you feel your icons are not being displayed properly, then you may also want to check
Remote Support's Information pane for any errors encountered when contacting the
affected systems.

Authentication
Authentication
All of the functionality in DameWare Remote Support, including installing, removing,
starting, or stopping the Mini Remote Control Client Agent Service on a remote system, is
accomplished by asking the Operating System on the local system to execute standard
Microsoft Windows APIs. This requires local Administrator rights to the Operating System
on the remote system, and uses either your current local logon credentials, or your
current authentication to the remote system.
In addition to local Administrator rights, these APIs require the following network
settings are enabled on the remote system:
l

File & Printer Sharing: ports 137-139, 445

l

Server Service: Domain environments only

l

NetLogon Service: Domain environments only

See also
l

Logon As

l

Smart Card authentication
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Smart Card authentication
When connecting to a remote computer from a computer with a Smart Card reader, you
can use your Smart Card to authenticate instead of manually providing a "Connect As"
username and password.
To authenticate to a remote computer using a Smart Card:

1. Select a remote computer in the left pane.
2. From the Tools menu, select Logon As.
3. In the Remote Logon window, click Use Smartcard.
4. In the User name field on the Smart Card Remote Authentication window, select
your Smart Card.
5. In the PIN field, enter your Personal Identification Number (PIN).
6. Click OK.
7. Back on the Remote Logon window, select the appropriate connection options.
8. Click OK.
In addition to the general authentication requirements (see Authentication), Smart Card
only environments where user IDs and passwords are no longer allowed have the
following requirement:
Administrators must be able to map a network drive and/or access shared resources on
remote systems using their Smart Card. To test whether this is allowed, run the following
command from a Command Prompt on the administrator's computer, where

remoteSystem is the machine name of the remote system and Resource is a shared
resource on that system:

Net Use X: \\remoteSystem\Resource /smartcard
If you cannot access resources on remote systems using your Smart Card, you will not be
able to use any of the Remote Support functionality. Furthermore, you will not be able to
install, remove, start, or stop the DameWare Mini Remote Control client agent service on
the remote system using Smart Card authentication. This is strictly a requirement of
Microsoft, not directly of our software.
If your Smart Card environment still allows administrators to authenticate using a user
ID and password, authenticate to the remote system with Administrator credentials to
gain access to Remote Support functionality on that remote system.
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Active Directory Browser
Active Directory overview
The DameWare Remote Support Active Directory (AD) administration tools simplify
directory service administration and allow administrators to remotely manage multiple
Active Directory sites directly from their workstation, without being physically logged into
any domain.
For example, an Administrator can be logged into Domain A, or even working from home
over a VPN connection without being logged into any Domain. He can then use Remote
Support to perform Administrative tasks on Domain B, including Active Directory and
Exchange tasks, without having to log into Domain B.
To access these tools, expand the Active Directory node in the Network Browser pane.
Remote Support's Active Directory functionality is only supported on systems running
Windows Vista and higher.

Active Directory Support
Use Remote Support to manage Active Directory on any domain to which your computer
belongs. Remote Support uses the DameWare AD & Exchange Agent for management
tasks, which it automatically deploys from your computer to the domain controller or
Exchange server you want to administer.
To specify the Active Directory servers you want to manager:

1. In the Remote Support Network Browser pane, expand the Active Directory node.
2. From the AD menu, select Add Active Directory Site.
3. Enter the name or IP address for the AD site, and then click Check.
4. If the dialog returns the correct information, click OK.
You can add a new user, create their home folders with the correct security settings,
create an Exchange Mailbox for the user, and even add their picture – all from within
Remote Support.
Active Directory Group Policy Objects and Organizational Units

To manage your Group Policy Objects (GPO) and Organizational Units (OU) from within
DameWare Remote Support, right-click the Active Directory site you would like to
manage, and then select the appropriate option:
l

Account Policy: View and edit the AD site's account policy.

l

Audit Policy: View and edit the AD site's audit policy.
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l

l

Browse Group Policy Objects: View and edit the GPOs for related domains, OUs,
sites, and computers.
Open Group Policy Objects: Open the Group Policy Object Editor for the AD site.

Microsoft Exchange support

To manage Microsoft Exchange mailboxes for specific users from within Remote Support,
right-click the user from the User Objects view, point to Exchange Tasks, and then select
the appropriate option:
l

Create Mailbox: Create a new Exchange mailbox for the selected user.

l

Move Mailbox: Move the selected user's mailbox to a different location.

l

Delete Mailbox: Delete the selected user's mailbox.

l

Establish e-mail addresses: Establish an email address for the selected user.

l

Delete e-mail addresses: Delete an email address for the selected user.

l

Update Now: Updates the selected user's Exchange account.

You can also access other Exchange settings on the Exchange General, Email-Addresses,
or Exchange Advanced tabs on the User Properties view: right-click a user in the User
Objects view, and then select Properties.
If these tabs are not available, select View Advanced Features on the Active Directory
tab in the Remote Support Properties view.
Microsoft Exchange and the DameWare AD & Exchange Agent

Exchange functionality does not necessarily require the DameWare AD & Exchange
Agent. Remote Support automatically detects if the Microsoft Exchange Admin tools are
installed locally. Remote Support uses the Exchange tools if it finds them. Otherwise,
Remote Support attempts to install a DameWare AD & Exchange Agent.
Remote Support's Exchange Tasks are only available if Remote Support detects
Microsoft Exchange 2000 or greater on the selected AD site. The Exchange server
must also be an AD domain controller for the domain. If your Exchange server is
not running AD, the Exchange Tasks menu does not function properly, and its task
will return an error.
To add an Exchange server running AD as an AD site in Remote Support:

1. In the Remote Support Network Browser pane, expand the Active Directory node.
2. From the AD menu, select Add Active Directory Site.
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3. Enter the name or IP address for the Exchange server, and then click Check.
4. If the dialog returns the correct information, click OK.

Active Directory objects
In simplest terms, Active Directory is basically a database of Objects and their
corresponding attributes. Every resource in Active Directory is represented as an object,
such as Contacts, Shares, OUs, Servers, Workstations, Printers, Domains, Users, and
Groups. All Active Directory Objects in Remote Support are displayed in a consistent style
AD Object Viewer layout.
Each AD site under the Active Directory node in the Network Browser pane has the
following containers under it:
Active Directory Computers

Remote Support's Active Directory Computers container contains a list of all computers
within the selected AD Domain. Use this list to quickly find a Computer without having to
drill down through all OUs & Containers.
Active Directory Quick OUs

Remote Support's exclusive Quick OUs container allows Administrators to create
shortcuts to commonly used OUs.
Active Directory Users & Computers

Remote Support's Active Directory Users & Computers is very similar to Microsoft Active
Directory Users & Computers tool, except when using Remote Support you are not
restricted to being a member of the Domain or being physically logged into the Domain.
Active Directory Users & Computers objects are divided into the following default
containers. However, in addition to these default containers, you can also organize AD
Objects in logical units by creating containers called organizational units (OUs).
Double-click any container in this list to open the corresponding Objects view in the
center pane.
l

l

l

Builtin: Active Directory Builtin Objects contain objects that define the default
built-in groups, such as Account Operators or Administrators.
Computers: Computer objects contains Windows Server computer objects.
Domain Controllers: Domain Controller Objects are computer objects for
machines serving as domain controllers running a Windows Server Operating
System (i.e. Windows Server 2008, 2012, etc.).
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l

l

l

l

ForeignSecurityPrincipals: ForeignSecurityPrincipals contain information on
objects from a trusted external domain. Normally, these objects are created when
an object from an external domain is added to a group in the current domain.
LostAndFound (Advanced View Only): LostAndFound objects are objects whose
containers were deleted at the same time the object was created. If an object has
been created in or moved to a location that is missing after replication, the lost
object is added to the LostAndFound container. LostAndFound objects basically
stores Active Directory objects that have been orphaned. Available in Advanced
View only.
System (Advanced View Only): System Objects contain built-in system settings
for various system service objects & containers. Available in Advanced View only.
Users: Default container for user objects.

Microsoft Windows Network Browser
Microsoft Windows Network Browser overview
The DameWare Remote Support Network Browser tree view displays all Microsoft
Windows Network components in an explorer tree view. This window displays all
domains and systems available in the Microsoft's Windows Network Browser list
(equivalent to My Network Places or Network Neighborhood). Remote Support displays
available domains in a collapsed tree view, with a dynamic count of member servers and
workstations next to them. Expand these containers to list all active systems that belong
to that domain.
Remote Support dynamically changes available menu items depending on the current
selection. For example, if you open the Groups view for a domain controller, Remote
Support displays the global groups for that domain. On the other hand, when you open

Groups from a workstation, Remote Support displays the workstation's local groups.

Favorite Domains
Favorite Domains
DameWare Remote Support includes a feature that allows you to add, edit and delete
domains that are used more frequently than others to the Favorite Domains list. Similar
to the Active Directory Quick OUs & Favorite Machines features, Favorite Domains
provides a quick view and access to a custom domain list.

Favorite Machines
Favorite Machines
DameWare Remote Support incorporates a special feature that allows you to add, edit
and delete systems that are not automatically included in Microsoft's Windows Network
Browser list. Systems added to the Favorite Machines list can be entered by machine
name or IP address.
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DameWare Remote Support also allows you to add systems in a range of IP Addresses.
For example, add systems that utilize dial up connections, hidden machines, or systems
that are physically connected to different networks.
Provided you have the appropriate administrative permissions to the systems listed
under Favorite Machines, you can run many of the integrated Remote Support utilities
and custom tools against these systems. For additional information, see Authentication.

Global Host List
Global host list
DameWare Central Server administrators can create a common list of hosts that are
available to all technicians by installing the DameWare Central Server and upgrading all
consoles to use Remote Support or Mini Remote Control in centralized mode in version
12.0.4.
Technicians can access the host list in the Remote Connect dialog after logging on to the
application.
For more information about creating global host lists, see the online help.

Personal Host List
Personal host list
You can create your own host list that follows you to different installations of the Remote
Support or Mini Remote Control applications. This feature is available to DameWare
Central Server users (version 11.0 and later) with Remote Support or Mini Remote
Control running in centralized mode.
Changes you make to your personal host list are saved to the Central Server. Every time
you log in to Remote Support or Mini Remote Control running in centralized mode, the
application queries the Central Server for your personal host list.
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Toolbar buttons
Active Directory toolbar

Add Active Directory Site
Edit Active Directory Site Settings
Remove Active Directory Site
GoTo (Active Directory) – see GoTo.

Standard toolbar

Add Favorite Domain or Favorite Machines
Edit Favorite Domain or Favorite Machines
Delete Favorite Domain or Favorite Machines
GoTo (Machine) – see GoTo.
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Tools toolbar

Application Properties
Stop Current View action
Refresh Current View
Logon As
Disconnect Network Connections
Print (active view)
Print Preview (full page display)
About Remote Support
Help Topics

GoTo
Opens the GoTo dialog window. In the GoTo dialog, enter a machine name or IP address,
and Remote Support directs you to the specified computer in the network browser pane.
If the computer is not available in the network browser, Remote Support asks if you want
to add the computer to the Favorite Machines list.

Logon As
The Logon As function of DameWare Remote Support provides remote logon capabilities
to any computer or domain you specify. Save credentials for use later, or clear that
option to instruct Remote Support to prompt for credentials every time you connect to a
remote computer.
To specify credentials in the Remote Logon dialog:

1. In the Machine Name field, enter the machine name or fully qualified domain
name of the computer or domain you want to connect to.
If you selected a specific computer in the Network Browser pane before
clicking Logon As, this field already contains that computer's machine
name.
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2. In the Connect As field, enter the user ID you want to use to connect to the
specified computer. This field accepts user IDs in both userID and
DOMAIN\userID format.
3. In the Password field, enter the password for the account you entered.
4. Select any of the following options as applicable:
l

l

l

Close any current connections to this machine: Closes any current
connections so you can reconnect as the specified user.
Remember Security Credentials: Saves the credentials for the specified
computer or domain.
Set as default Security Credentials: Saves the credentials as the default
credentials for all connections that do not have other credentials specified.

5. Click OK.
For information about Smart Card authentication, see Smart Card authentication.

Disconnect Network Connections
The Disconnect Network Connections dialog displays all current network connections. To
disconnect from a computer or domain, highlight the computer or domain (use

Ctrl+click to select multiple connections), and then click Disconnect. The Refresh
button refreshes the window view with the current network connections.
The following options are disabled by default:
l

l

Show Machines Connections: Displays any machines' connections.
Show Disconnected Connections: Displays any current disconnected
connections.

When you are finished with the dialog, click Close to close the window.
The Disconnect Network Connections dialog window presents the following columns of
information to the user.

C
OLUMN

Status

INFORMATION
Displays current status of the network connection.
Displays the local drive letter associated with a local

Local

drive connection. Displays None for non-local drive
connections.

Displays the UNC name of the connection. For
Remote example, \\machinename\IPC$, \\machine\home, or
\\machine\Admin$.
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C
OLUMN

User ID

INFORMATION
Displays the User ID that is authenticated to this
connection. For example, mydomain\administrator.
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Remote System Tasks and Views
Active Directory Objects view
The Active Directory objects view looks the same regardless of the type of AD object you
are viewing. The fields at the top of the view display the total number of objects in the
selected container and the number of objects in the current view, respectively. These
two numbers are the same unless of have applied a filter using the AD Filter toolbar.
The main area of the AD objects view displays the objects' details in the following 3 tabs.
List tab
Displays the currently selected AD objects in a list-style view (default).
Tree tab
Displays the currently selected AD objects in a tree-style view.
Picture tab
Displays the currently selected AD objects in the picture viewer. Use the picture viewer
to manage photos and logos for each applicable AD object. Upload image files to use as
ID pictures and company logos, and view them along with the user's name, AD object
type, and description.

Batch Processing
Batch Processing allows Remote Support administrators to execute certain tasks
throughout the Remote Support interface against a group, or batch, of systems from a
single view. When a view supports Batch Processing, the Batch pane appears at the
bottom of the view.
To execute a Batch Processing task:
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1. Add one or more systems to the Batch list using any of the following methods:
l

l

l

Open a pre-configured batch machine file.
Drag the systems you want to include into the Batch pane from the Network
Browser pane.
Click the menu for the view at the top of the Remote Support window, and
then select Add Machine.

2. If you want to save your list of systems for future use, click the Save As icon on the
Batch mini toolbar, and then enter a new name for your batch list.
3. In the Batch pane, select the systems you want to include in the task. Hold Ctrl or
Shift to select multiple systems.
4. Click the menu for the view at the top of the Remote Support window, and then
select Batch Processing.
5. Complete the Batch Properties window according to the current view.
6. Click OK.
After you run the Batch, the icons in the Batch list change according to the status of the
task.
The Status column returns the following status codes based on the results of a batch
task:
l

None: No Batch has been performed.

l

Complete: The Batch completed as configured.

l

Error: The Batch item failed. Refer to the Error column for additional details.

l

Pending: The Batch item is in the queue to be scheduled on that system.

l

Active: The Batch item is in progress on that system.

Disk Drives
Disk Drives view
DameWare Remote Support Disk Drives view provides an easy interface to enumerate
the disk drives on a remote computer. After the system enumerates the drives, you can
open a Windows Explorer view without having to previously map the drive. The Disk
Drives view displays the number of disk drives on the remote computer, along with
details for each drive in the following sortable columns:
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l

the drive letter

l

the disk drive's format

l

total units

l

free units

l

units used

l

percent free

l

percent used

Use the buttons on the Disk Drives view mini toolbar to specify the unit of
measurement you want to use for the Disk Drive view.
The following icons distinguish the disk drive type(s):
Diskette or removable drives
Hard disk drives
CD-ROM
Other drives - Unknown type

Disk Drive Details
When you double-click a drive in the Disk Drive view, the system opens the Disk Drive
Details dialog, which displays the following details:
l

Volume name

l

Serial number

l

File System

l

Sectors/Cluster

l

Bytes/Sector

l

Free clusters

l

Clusters

l

Total Space (in bytes)

l

Free Space (in bytes)

l

Flags
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Event Log
Event Log view
Remote Support provides a custom Event Log view with many enhancements over the
standard Windows Event Viewer. Remote Support's Event Log view displays a total count
of all entries in the list and then dynamically loads a number of entries at a time. It then
loads the remaining entries and updates the appropriate counter(s) with the number of
entries read in a lower priority thread. Specify the maximum number of log entries the
Remote Support retrieves in the Event Log tab of the DameWare Remote Support
Properties window. For additional information, see Event Log tab.
Use Remote Support's Event Log view to view and manage the Application, Security, and
System Event Logs on remote systems. Switch between event logs by selecting the
corresponding tab from the top of the Event Log view.
The following icons illustrate the type of event in the far-left column:
Information event
Error event
Warning event
Success Audit event (Security Event Log)
Failure Audit event (Security Event Log)
Windows stores the event logs in the following default locations:
l

Application Event Log: %SYSTEMROOT%\system32\config\AppEvent.Evt

l

System Event Log: %SYSTEMROOT%\system32\config\SysEvent.Evt

l

Security Event Log: %SYSTEMROOT%\system32\config\SecEvent.Evt

Event Details
When you double-click an entry in the Event Log view, the system opens the Event Detail
window. The Event Details dialog allows easy navigation with Up and Down buttons.
Additionally, you can copy the event log details to the clipboard to paste into other
applications.

Open saved Event Logs
When you click the File tab at the top of the Event Log view the system prompts you to
open a previously saved Event Log (.evt) file.
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Save Event Logs
When you choose to save an event log using the Event Log view mini toolbar or context
menu, the system opens the Save Event Log As dialog. Use this dialog to browse to the
folder in which you want to save the event log and specify its file name. Event logs
always use the file format Windows Event Log file format (.evt).

Clear Event Logs
When you clear an event log using the Event Log view mini toolbar or context menu, the
system clears all of the events from the selected event log. After you clear events from an
event log, only new events show in the Event Logs view.
If you want to clear events from a previously saved event log, delete the EVT file of the
event log from the remote computer.

Event Log properties
View and edit event log properties using the Event Log view mini toolbar or context
menu. The Event Log Properties window displays the location and file name of the
selected log, provides its size settings, and defines its filtering parameters.
To modify an event log's size settings:

1. In the Event Log view, click

.

2. In the Display Name field, select the event log you want to modify.
3. In the Log Size section, enter or select a size in the Maximum Log Size field.
4. Under When maximum log size is reached, select one of the following:
l

Overwrite Events as Needed

l

Overwrite Events Older than XX Days

l

Do Not Overwrite Events (Clear Log Manually)

5. Click OK.
To define the filtering parameters for an event log:

1. In the Event Log view, click

.

2. In the Display Name field, select the event log you want to modify.
3. In the Event Types section, select the types of events you want to see.
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4. If applicable, select or enter a filter value in any of the following fields:
l

Event Source

l

Category (only applicable if you specify an Event Source)

l

Event ID

l

User

l

Computer

5. In the From and To fields, specify a start and end time for the log to display.
6. Click OK.
For information about how to apply event log filters, see Event Log filtering.

Event Log filtering
When you choose to filter an event log using the Event Log view mini toolbar or context
menu, the system applies the filter defined in the event log's properties. By default,
Remote Support displays the event logs of remote systems in their unfiltered state.
For additional information about how to define event log filter parameters, see Event Log
properties.

Explore Network view
Use Remote Support's Explore Network view (Tools > Explore Network) allows you to view
a variety of network logical components by domain. Use the menu at the top of the view
to switch between domains. Use the tabs across the top of the view to specify the type of
systems you want to see. The Total Matches value shows the total number of systems
that match the current query, based on your domain and tab selection.
Expand nodes in the result window for additional information about the system,
including:
l

Primary Role

l

Description

l

Version

l

Platform ID

l

Flags (system attributes)
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Groups view
DameWare Remote Support supports both Local and Global group administration. When
you open the Groups view from the Network Browser pane, Remote Support determines
the role that the selected machine is playing in the network and then displays the
appropriate Groups view, either Local or Local and Global. Use the Groups view to view,
add, or delete groups relative to the computer you selected prior to launching the view.
The following icons distinguish the group type(s) in the far-left column of the Groups
view:
Local groups
Global groups

Definitions
Global groups
Global groups contain user accounts from the domain in which they are created. A global
group name cannot be identical to any other user or group name in the domain or
computer being administered. It can contain up to 20 uppercase or lowercase characters
except for the following: 'r; / \ [ ] : ; | = , + * ? < >
A global group name cannot consist solely of periods (.) and spaces.
Local groups
Local groups can contain user accounts and global groups from the domain in which
they are created and in any trusted domain. Local groups cannot contain other local
groups. A local group name cannot be identical to any other group or user name of the
domain or computer being administered. It can contain up to 256 uppercase or
lowercase characters except for the backslash character (\).

Intel AMT
Intel AMT overview
Intel Active Management Technology (AMT) allows system administrators to manage
remote systems at the hardware level, even when the system is powered off. DameWare
Remote Support integrates with this technology, allowing you to mount CD, DVD, or
floppy images on the remote computer and turn remote systems on and off, regardless
of the hardware state. Intel AMT only works with Intel systems equipped with vPro
technology.
If your systems are capable, enable vPro and then use Remote Support or Mini Remote
Control to connect to the system. For additional information about how to enable vPro on
capable systems, see Intel AMT vPro setup.
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Intel AMT Virtual CD/Floppy dialog
The Virtual CD/Floppy dialog under Intel AMT in the Remote Support network browser
allows you to mount CD, DVD, or floppy images or physical disks on remote systems
enabled with Intel AMT technology. When you execute this task, Remote Support
attempts to mount the drive you select. After you have selected a drive or image file, use
the following radio buttons to specify what you want to do, and then click Mount.
l

No change
Mounts the image or drive on the remote system but does not boot from the image
or drive

l

Boot from ISO
Attempts to boot from the selected CD or DVD image or drive when the computer
reboots

l

Boot from IMG
Attempts to boot from the selected floppy image file or drive when the computer
reboots

Note: You cannot power off a remote system using the Intel AMT Power Management
dialog while a remote drive is active.
For additional information about enabling Intel AMT functionality on remote systems, see
Intel AMT vPro setup.

Intel AMT Power dialog
The Power dialog under Intel AMT in the Remote Support network browser allows you
to power on, power off, or reboot remote systems enabled with Intel AMT technology.
When you execute this task, Remote Support attempts to detect the current power state
of the remote system. If the system is AMT-enabled, Remote Support returns the
system's state at the bottom of the dialog. Use the following radio buttons to specify
what you want to do, and then click Apply.
l

Power On

l

Power Off

l

Reboot

For additional information about enabling Intel AMT functionality on remote systems, see
Intel AMT vPro setup.

Intel AMT Settings dialog
Use the Settings dialog under Intel AMT in the Remote Support network browser to
specify security settings for remote vPro AMT hosts. This dialog contains two options:
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Use TLS
Select this option if you use Transport Layer Security (TLS) to connect to remote systems.
If you require secure connections between servers and clients, ensure all systems have
the appropriate certificates in their Trusted Root Certification Authorities and
Personal certificate stores.
Use HTTP proxy
Select this option if you use a proxy server to connect to remote systems. Enter the
hostname and port number for the proxy server Remote Support should use. If
necessary, also provide the username and password required by an authenticated proxy.
Do not use DameWare Internet Proxy information. The DameWare Internet Proxy is
only used for Internet Sessions.

Intel AMT vPro setup
The Intel AMT > Power task in Remote Support allows users to connect to remote
systems running on Intel vPro hardware that supports the AMT KVM feature. For this to
work, enable the AMT KVM feature on your vPro hardware.
To configure Intel vPro hosts for AMT KVM connections:

1. Reboot the host, and then enter its BIOS configuration menu.
2. Under AMT Options, select the following options:
l

Firmware Verbosity

l

AMT Setup Prompt

3. Reboot the host, and then enter the Management Engine BIOS Extension (MBEx):
Just after the BIOS startup screen, press Ctrl+P.
4. If you are prompted for a password, enter the default password, admin, and then
create a new password.
5. In the Intel ME Platform Configuration menu, select Activate Network Access.
6. In the Intel ME Network Setup menu, select Intel ME Network Name Settings.
7. Select Host Name, and then enter the hostname for the host.
8. Press Esc to return to the previous menu.
9. Select Manageability Feature Selection, and then ensure it is enabled in the
lower pane.
10. Select SOL/IDER.
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11. In the SOL/IDER menu, enable the following options:
l

SOL

l

IDER

l

Legacy Redirection Mode

12. Return to the previous menu, and then select KVM Configuration.
13. In the KVM Configuration menu, select KVM Feature Selection, and then ensure
it is enabled in the lower pane.
14. In the upper pane, select User Opt-in, and then select User Consent is required
for KVM Session in the lower pane.
15. In the upper pane, select Opt-in Configurable from remote IT, and then select
Enable Remote Control of KVM Opt-In Policy in the lower pane.
16. Press Esc until you are prompted to leave the MEBx menu.
Source: http://www.howtogeek.com/56538/

Members
Members view
Use Remote Support's Members view to add and remove computers to/from a domain. If
you are running an NT4 domain, the Members view provides a Synchronize the Entire
Domain option in the view's context menu. DameWare Remote Support dynamically
determines the role the computers within the Members view are playing and displays
the appropriate icon for that computer type. Toggle the scope of the Members view
using the corresponding buttons on the Members view mini toolbar. For example, click
to view only workstations.
The Members view displays the Computer Count and Status at the top of the view, along
with the following sortable columns:
l

Computer name

l

Type

l

Description

l

Version

The Synchronize Monitor view provides functionality to synchronize a Backup Domain
Controller with the Primary Domain Controller and force full synchronization with the
Primary Domain Controller. For additional information, see Synchronize Monitor view.
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Synchronize Monitor view
The Synchronize Monitor view contains several columns of information for both the
Selected Domain Controller and All Domain Controllers within a domain:
l

l

l

Machine: The name of the selected Primary Domain Controller or Backup Domain
Controller.
Sync. Item: A description of the sync item.
Status: In the case of sync item Connection Status, this contains any error that
may occur or zero (0), if no errors.
All other sync items indicate Yes if sync item is occurring or No, if sync item is not
occurring.

l

Last: The data and time the sync item last occurred.

l

Count: The number of times the sync has occurred.

l

Error: The error condition.

It is possible to miss a sync event if the event occurs between checks. A smaller
refresh interval could help eliminate this condition.

NetLogon Service
The NetLogon Service automatically synchronizes changes in the Windowsdirectory
database stored on the Primary Domain Controller (PDC) to all Backup Domain
Controllers (BDC). Based on settings in the registry, the PDC sends timed notices that
signal the BDCs to request changes at the same time. When a BDC requests changes, it
informs the PDC of the last change it received so that the PDC can determine whether a
BDC needs updating. If a BDC is up to date, its NetLogon service does not request
changes.
The NetLogon Service synchronizes three domain directory databases: the security
accounts manager (SAM) database, the SAM built-in database, and the Local Security
Authority (LSA) license database.
SAM database
Contains Microsoft domain user and group accounts that you create. Includes all
computer accounts added to the domain such as domain controllers (DCs) and Windowsbased computers.
SAM built-in database
Contains the local computer's built-in user and group accounts such as Administrator
and Domain Admins.
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LSA license database
Contains LSA Secrets that are used for trust relationships and DC computer account
passwords. Also includes the account policy settings that you configure.
Synchronization occurs:
l

When a backup domain controller is initialized or restarted in the domain.

l

When "forced" by a network administrator using Server Manager.

It occurs automatically by the DCs, depending upon members' registry configuration.
The change log records changes to the domain-directory databases, including new or
modified passwords, user and group and accounts and group membership and user
rights. Its size determines how many changes the log can hold and the duration.
Typically, the change log holds approximately 2000 changes, retaining only the most
recent changes and deleting the oldest ones first. When a BDC requests changes, it
receives only changes that occurred since the last synchronization.
The NetLogon Service checks for updates every five minutes (default). If a BDC does not
request changes in a timely manner, the entire domain directory must be copied to that
BDC. For example, if a BDC is offline for a time (such as for system repair), more changes
could occur during that timeframe than can be stored in the change log.
Partial synchronization consists of the automatic, timed replication of directory database
changes to all BDCs since the last synchronization. Full synchronization copies the entire
directory database to a BDC. This occurs automatically when changes have been deleted
from the change log before replication or when you add a new BDC to a domain.
Both the NetLogon Service updates and the change log size ensure that full
synchronization does not start up under most operating conditions. In the WAN
environment, you can control and refine NetLogon activity using the member registry
entries and a variation of the following method.
To reduce the number of full synchronizations needed in a WAN environment:

1. Build BDCs at the corporate network site so that the full directory database can be
quickly transferred from a PDC to BDCs.
2. Send the new BDCs to the branch offices
3. Put the new BDCs into service as soon as possible (within 3 to 6 days of dispatch).
When the new BDC starts up, it contacts the PDC to obtain any directory database
changes that occurred while the BDC was offline.
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Open Files view
The Open Files view displays a custom view that shows any files, folders, and pipes that
are open on the remote computer. The Open Files view displays the Open File Count and
Status at the top of the view, along with the following sortable columns:
l

UserID

l

Path

l

Access Type

l

Locks

l

ID

The only option available to you in this view are to select one or more open files, folders
or pipes and issue a disconnect on the item. When a disconnect is issued, DameWare
Remote Support prompts you with an information dialog containing the message,
"Forcing userID to close filename. May result in loss of data. Do you want to continue?"
Click Yes to disconnect, or No to return to the Open Files view without performing a
disconnect.
A pipe, by definition, is an interprocess communication mechanism that allows
one process to communicate with another local or remote process.

Printers view
The Printers view displays a custom view that lists all of the printers on the remote
system. Toggle the scope of the Printers view using the corresponding buttons on the
Printers view mini toolbar. For example, click

to view only shared printers.

The Printers window view displays the Printer Count and Status at the top of the view,
along with the following sortable columns, depending on the view tab:

Normal Listing
l

Printer Name (UNC)

l

Description

l

Comments

l

Container

Detailed Listing
l

Printer (name)

l

Share Name
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l

Location

l

Comments

l

Port Name

l

Driver Name

l

Separator File

l

Print Processor

l

Parameters

l

Jobs

When you select a printer, open the printer queue window from the Printers view mini
toolbar to pause, resume, restart, or cancel a print job. Open the printer's properties
window to manage properties such as the printer's sharing settings and port schedule.

Processes view
The Processes view is designed to allow robust remote process management
functionality. The Processes view displays the total number of processes currently
executing on the remote computer and its Central Processing Unit (CPU) utilization at the
top of the view. The Processes view also displays the details of each current process in
the following sortable columns:
l

Image Name

l

PID (Process Identifier)

l

CPU (% used)

l

CPU Time

l

Mem Usage (amount of memory used)

l

Privileged (% used in Privileged mode)

l

User (% used in User mode)

l

Threads (# running)

l

Start Time

l

Elapsed Time

When you select a process, the Processes view displays each of the Threads associated
with that process in the lower pane, with the following details:
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l

Processor Time

l

Privileged (% used in Privileged mode)

l

User (% used in User mode)

l

Priority

The Processes view's mini toolbar provides the following functionality:
End Selected Process
When selected, Remote Support presents a Warning dialog stating that terminating a
process can cause undesired results, including loss of data and system instability. To
terminate the process, click Yes. To return without terminating the selected process, click
No.
Run Application Remote
When this option is selected, the Remote Support displays the Run Task As dialog. In
this dialog, specify the application you want to run and the credentials you want to use
to run it. The dialog consists of the following fields/options:
l

l

l

l

Run: Enter the name of the application you want to run, or select an
application from a list of history items.
Show Window: Select whether you want the application window to
run in Normal, Minimized, or Hidden mode.
Load User Profile: Select this option if you want to run the application
under the context of the specified user profile.
Run As: Select this option to run the remote application using the
credentials you supply. If you do not specify credentials in this section,
the DameWare Remote Support Service impersonates the user
invoking this process.

If an error occurs during the execution of the remote process, the DameWare Remote
Support service writes an event to the application error log on the remote system.
Remote Support reminds you of this when you launch the remote application.
If you load a profile from a service, you will not be able to use that profile to log
into the console of the remote system. If the selected user logs onto the console,
the Windows operating system creates a new profile for the user. To avoid this,
create a local user account on the remote machine to use specifically for this
purpose.

- 38 -

Chapter 4
View Running Applications
When selected, Remote Support displays a dialog window listing all applications
currently executing on the selected machine. A total count is displayed at the top of the
window. Click Refresh to refresh the contents of the window.
Auto Update
The Auto Update feature is disabled by default. If you are accessing the remote system
through a fast network link, then you may wish to enable the Auto Update feature. When
enabled, the process information will be updated in real time.
Re-sort On Update
When selected, Remote Support re-sorts the Processes list according to the currently
selected sort column on each update.
Display Memory Details
When selected, Remote Support displays a dialog window listing the Process name,
Process ID and User Address Space information for individual resources used by the
process, including Mapped Commit and Private Commit statistics. The dialog also
displays Virtual Memory Counts information, including working set, pages, virtual sizes
and fault count.

User Mode and Privileged Mode
One aspect of thread behavior is whether it is running in User mode or Privileged mode.

User mode is the processing mode in which applications run. Threads running in user
mode are running in their own application code or the code of another user mode
process, such as an environment subsystem. Processes running in user mode cannot
access hardware directly and must call operating system functions to switch their
threads to Privileged mode to use operating system services.
Privileged mode, or kernel mode, is the processing mode that allows code to have direct
access to all hardware and memory in the system. For example, the Windows OS
executive services run in privileged mode. Application threads must be switched to
privileged mode to run in operating system code. Applications call privileged-mode
operating system services for essential functions such as drawing windows, receiving
information about user keyboard and mouse input and checking security.

Properties view
The DameWare Remote Support Properties view is implemented as an MDI child window
with eight tabs for categorized properties information. Use Batch Processing to update
the following properties on one or more selected computers from the lower pane of the
Properties view:
l

Machine Visibility

l

Legal Notice
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For additional information about Batch Processing, see Batch Processing.
The following sections discuss the Properties view tabs in more detail.

Time tab
Displays the following time information for the remote system:
l

Current Local Time: The actual time of the local system.

l

Current Remote Time: The actual time on the remote system.

l

l

l

Zone Difference: The difference between the time zones on the remote and local
systems.
Start Time: The last recorded start time of the remote system.
Up Time: The time in days, hours, minutes and seconds that the remote system
has been running. This counter is reset after 49.7 days or 4,294,967,295
milliseconds. Due to this limitation, Remote Support has an option to use the local
system's event log for this calculation.
If the event log on the remote system is cleared, this option is not viable.
Also, using the event log for this calculation can be time consuming,
especially with very large logs.

l

l

Remote to Local Time: This time is converted from the remote time to the local
time using the time zone of the local system. This is not the actual time on the local
system.
Time Variance: The calculated time difference between the remote and local
systems.

The Current Remote Time and Current Local Time may be the same if both the
remote and local systems are in the same time zone.

Version tab
Displays the following version information for the remote system:
l

Current Build Number

l

Current Type

l

Current Version (see table)

l

Install Date

l

Path Name
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l

Product Type

l

Registered Organization

l

Registered Owner

l

Software Type

l

System Root

Table of Operating System Names by OS Version
OS Version

Corresponding Operating System Name

5.1

Windows XP Home, Windows XP Professional

5.2

Windows Server 2003, Windows Server 2003 R2, Windows XP 64-Bit
Edition

6.0

Windows Vista, Windows Server 2008

6.1

Windows 7, Windows Server 2008 R2

6.2

Windows Server 2012, Windows 8

6.3*

Windows Server 2012 R2, Windows 8.1

10.0*

Windows Server 2016 Technical Preview, Windows 10

* For applications manifested for Windows 8.1 or Windows 10.

System tab
Displays the following system information:
l

Identifier

l

Bios Version

l

Bios Date

l

CPU Identifier

l

CPU Vendor Identifier

l

CPU MHz

l

CPU Name String

l

HAL

l

Physical Memory
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If the hardware manufacturer has provided it, Remote Support collects the following
additional information from remote systems using Windows Management
Instrumentation (WMI):
l

(Bios) Bios Manufacturer

l

(Bios) Bios Version

l

(Bios) SMBios Version

l

(Bios) Serial Number

l

(Computer System) Manufacturer

l

(Computer System) Model

l

(Computer System) System Type

l

(System Enclosure) Manufacturer

l

(System Enclosure) Asset Tag

Display tab
Displays the following display information:
l

Bios Date

l

Bios Version

l

Driver

l

Driver Company

l

Driver Description

l

Driver Product

l

Driver Version

l

Memory Size

Resources tab
Displays the following information on their respective tabs at the bottom of the view:

IRQ tab
Displays the following information about the remote system's interrupt requests (IRQ):
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l

IRQ (number)

l

Device

l

Bus

l

Type

I/O Port tab
Displays the following information about the remote system's input/output (I/O) ports:
l

Address

l

Device

l

Bus

l

Type

DMA tab
Displays the following information about the remote system's direct memory access
(DMA):
l

Channel

l

Port

l

Device

l

Bus

l

Type

Memory tab
Displays the following information about the remote system's memory resources:
l

Address

l

Device

l

Bus

l

Type

Devices tab
Lists the remote system's devices.
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Environment tab
Displays and defines all of the environment variables currently defined on the remote
system, including:
l

ComSpec

l

NUMBER_OF_PROCESSORS

l

OS

l

Os2LibPath

l

Path

l

PROCESSOR_ARCHITECTURE

l

PROCESSOR_IDENTIFIER

l

PROCESSOR_LEVEL

l

PROCESSOR_REVISION

l

windir

Network tab
Displays the following information on their respective tabs at the bottom of the view:

General tab
Displays general network information for the remote system, including:
l

Comment

l

Domain or Workgroup

l

Hidden*

l

Lan Root

l

Legal Notice Caption*

l

Legal Notice Text*

l

Logged On Users

l

Max Users

l

Network Version

l

Platform ID
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l

User

l

User Logon Domain

l

User Logon Server

l

User Path

l

User Per License

* You can modify these settings using Remote Support's batch processing functionality.
For additional information, see Batch Processing.

Transports tab
Displays the following information for the remote system's transports:
l

Transport (name)

l

Address

l

VC's

l

WAN

l

Quality

Settings tab
Displays the following settings and their current values for the remote system:
512 Byte Max Transfer

Buffer Deny Write Files

Buffer Pipes

Buffer Read Only Files

Cache Time Out

Character Buffer Size

Character Wait

Character Time

Datagram Reset Frequency

Dormant File Limit

Force Core Creation

Illegal Datagrams

Keep Connection

Lock Increment

Lock Quota

Log Election Packets

Mailslot Buffers

Maximum Collection Count

Maximum Commands

Maximum Locks

Maximum Pipes

Maximum Threads

Pipe Increment

Read Ahead Throughput

Server Announce Buffers

Session Time Out

Use Close Behind

Use Encryption

Use Lock

Read

Unlock

Use Opportunistic Locking

Use Raw Read
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Use Raw Write

Use Unlock Behind

Use Write Raw Data

Statistics tab
Displays the following statistics and their current values for the remote system:
Bytes Transmitted

Cache Read Bytes
Requested

Cache Write Bytes Requested

Character Wait

Core Connects

Current Commands

Failed Completion
Operations

Failed Sessions

Failed Use Count

Hung Sessions

Initially Failed Operations

Large Read SMBs

Large Write SMBs

LM 2.0 Connects

LM 2.x Connects

Network Read Bytes

Non Paged Write Bytes

Requested

Requested

Paged Read Bytes
Requested

Paged Write Bytes
Requested

Random Read Operations

Read SMB's

Reconnects

Server Average Response
Time

Server Big Buffers Needed

Server Bytes Received

Server Bytes Sent

Server Device Opens

Server Disconnects

Server File Opens

Server Jobs Queued

Server Password Errors

Server Permission Errors

Server Request Buffers
Needed

Server Sessions Open

Server Sessions Errored Out

Server Sessions Timed Out

Server System Errors

Sessions

Small Read SMBs

Small Write SMBs

SMBs Received

SMBs Transmitted

Use Count

Windows Vista/2008/7
Connects

Write Operations

Write SMBs

Network Errors

Hotfixes tab
Displays the following information about the hotfixes on the remote system:
l

Hotfix (name)

l

Valid
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l

Installed

l

Installed By

l

Installed On

l

Description

l

Comments

RAS view
The RAS view only supports RAS (Remote Access Service), not RRAS (Routing and
Remote Access Service). Beginning with Windows 2000, Microsoft combined both
routing and remote access into a single service (RRAS).
DameWare Remote Support provides two levels of Port statistics from within the Remote
Access Service (RAS) Administration view: Port Status and Port Performance Data. Toggle
between the two views using the Port Status/Port Performance Data icon in the RAS
view mini toolbar.
The Port Status view displays information such as Port statistics, Connection Statistics,
Device errors and Remote Workstation information.
The Port Performance Data view actually connects to the Performance counters that
are tracked by the operating system. The Port Performance Data contains more detailed
information related to bytes, frames, compression, device errors and timeouts.
Configure the refresh delay for the RAS Administration view on the RAS tab of the
DameWare Remote Support Properties window. For additional information, see RAS tab.

Select a server or domain to administer
You must have administrator privilege or server operator and account operator
privileges for the domain or server you select to administer.

Dial-Up Networking overview
Dial-Up Networking is the client version of Windows Remote Access Service (RAS). Dial-Up
Networking allows remote users to work as if they were connected directly to the
network. Microsoft does not support access to Macintosh volumes and AppleTalk
printers over dial-in lines. A Windows RAS configuration includes the following
components:

Dial-Up Networking clients
Windows for Workgroups, MS-DOS (with Microsoft network client software installed) and
LAN Manager RAS clients can all connect to a Windows RAS server. Clients can also be
any non-Microsoft PPP client.
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RAS Servers
The Windows Server RAS permits up to 256 remote clients to dial in. Windows
Workstation permits one remote client to dial in. The RAS server can be configured to
provide access to an entire network or restrict access to the RAS server only.

LAN protocols
LAN protocols transport packets across a local-area network (LAN) whereas remote
access protocols control the transmission of data over the wide-area network (WAN).
Windows supports LAN protocols such as TCP/IP and RAS, IPX and RAS and NetBEUI and
RAS, which enable access to the Internet and to NetWare and UNIX servers. Windows
Sockets applications over TCP/IP or IPX, named pipes, Remote Procedure Call (RPC) and
the LAN Manager API are supported.

Remote Access Protocols
Windows supports Remote Access Protocols such as PPP, SLIP on RAS clients and the
Microsoft RAS Protocol.

WAN options
Clients can dial in using standard telephone lines and a modem or modem pool. Faster
links are possible using ISDN. You can also connect RAS clients to RAS servers using X.25,
an RS-232C null modem or using the Point-to-Point Tunneling Protocol (PPTP).

Security features
Clients can dial in using standard telephone lines and a modem or modem pool. Faster
links are possible using ISDN. You can also connect RAS clients to RAS servers using X.25,
an RS-232C null modem or using the Point-to-Point Tunneling Protocol (PPTP).

Internet support
RAS enables Windows to provide complete service to the Internet. A Windows Server
computer can be configured as an Internet Service Provider, offering dial up Internet
connections to a PPP client. A computer running Windows Workstation can dial into an
Internet connected computer running Windows Server 3.5 or later or to any one of a
variety of industry standard PPP or SLIP-based Internet servers.

RAS Servers
Windows Server administrators use the Remote Access Admin program to control the
RAS server, view users, grant permissions and monitor remote access traffic. For more
information about using the Remote Access Admin program see Rasadmin.hlp.
The server must have a multi-port adapter or modems (9600 baud or above is
recommended for acceptable performance), analog telephone lines or other WAN
connections and the RAS software installed. If the server will provide access to the
network, a separate network adapter card must be installed and connected for each
network the server will provide access.
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RAS servers are configured during initial RAS setup. You must specify whether access
will be to the entire network or to the RAS server only. You must also select the protocols
to use on the LAN (IPX, TCP/IP and NetBEUI) and an authentication encryption option.
Ports on RAS servers are configured individually. Each port can be set to Dial Out Only,
Receive Calls Only or Dial Out and Receive Calls. These settings affect only the port
specified, not all ports. For example, your RAS server can be configured to receive calls
and COM2 can be configured for dial out and receive. A remote user can call in on either
COM port but a local user can use only COM2 for outbound RAS calls.
Events and errors are recorded in Event Viewer on Windows RAS clients and servers.
Evaluating the log in the Event Viewer can help you determine the source of problems.
The Windows Server RAS permits up to 256 remote clients to dial in. The RAS server can
be configured to provide access to an entire network or restrict access to resources on
the RAS server only.

Use Windows Server to provide Internet access
In conjunction with a router and Internet service provider, Windows Server acts as a
gateway to the Internet for remote clients. Up to 256 clients can dial into the RAS server
using standard telephone lines, ISDN lines, X.25 or PPTP. The clients then use any PPP
compliant software or Windows computer together with Internet browsing tools to access
the Internet.

The Internet connection
The Internet connection to your site will typically be made through a leased line to a
router located on your network. Thus data travels over the Internet, over a leased line to
a router, through the router, over you local network, to the RAS server and then to remote
clients.

Registry view
The DameWare Remote Support Registry view provides a robust and easy to use
interface to manage the registry on both local and remote systems. Use Batch Processing
to import registry files to one or more selected computers from the lower pane of the
Registry view. For additional information about Batch Processing, see Batch Processing.
The upper portion of the Registry view shows the registry hives and keys in the left pane,
and the names and values for the selected registry key in the right pane. Use the
Registry view to do any of the following:
l

Export the selected registry hive(s)/key(s) to a .REG file

l

Import .REG files to one or more systems

l

Add or change values for REG_BINARY data types.
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Remote Support supports registry files that are in Microsoft RegEdit4 signature
file format. Remote Support's Registry view currently does not support the
following functionality:
l

Batch deleting Registry keys

l

REGEDIT5 formatted registry (.reg) files

l

Changing registry key permissions

Rules for registry components
The following rules govern the content of registry value entry components:
l

l

The name of the value is a string of up to 16,000 Unicode characters (32K). This
name can contain backslash (\) characters. The name itself can be null (that is, " ").
The data type of the value is REG_BINARY, REG_DWORD, REG_EXPAND_SZ, REG_
MULTI_SZ or REG_SZ. The DameWare Remote Support Registry view, as well as the
Vista/2008/Windows 7/Windows 8/Windows 8.1/Windows 10 Registry Editor, allows
edits values of these types only.

l

l

l

The value in a value entry can be data of a size up to 1 MB in any data type except
REG_DWORD, including arbitrary strings and raw binary data. However, to be
efficient, values larger than 2048 bytes should be stored as files with the filenames
stored in the Registry.
The Registry preserves case as you type it for any entry but ignores case in
evaluating the data. However, the data is defined by specific applications (or users)
so applications that use the data might be case sensitive depending on how the
program that uses it treats the data.
Numeric values and ranges that take the REG_DWORD data type can be expressed
as either hexadecimal or decimal numbers, or in hex or decimal base. If the
defined value is represented in a hexadecimal base, the value is preceded by 'r;0x'
to indicate that it is hexadecimal.

l

To assist you in applying changes to hexadecimal-base value entries or
interpreting the current values, you can use a scientific calculator, such as the
Calculator application (Calc.exe) to make conversions between hexadecimal and
decimal values.
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Remote Command view
DameWare Remote Support provides a Remote Command View and Remote Command
Console that enables you to execute commands and kill processes on remote systems.
When you select either of these options for a remote system, DameWare Remote Support
determines whether Remote Support's service is installed or not. If it is not, Remote
Support asks you whether it should install the DameWare Remote Support service on the
remote system. With the DameWare Remote Support service installed, the Remote
Command View/Console connects with the Remote Support service on the remote system
and displays the Status, Remote Command Ready.
You can stop and restart the DameWare Remote Support service at any time from
the Remote Command View by clicking the corresponding buttons on the minitoolbar. For example, stop the service if you want to keep the service installed on
the remote system, but would like to conserve memory while the service is not
being used.
Remote Command from Remote Support is secure in two ways:
The logged on user must have interactive logon privileges on the target computer
in order to connect to it.

l

Any programs executed on the target computer are executed impersonating the
logged on user. Any access validation (such as opening files) is performed as if the
user were logged on to the local computer.

l

Notes:
l

l

l

All Windows Workstation users have interactive logon privileges by default.
Anyone who can locally log on to your system can transparently access it over the
network unless you configure it otherwise. For Windows Server users, however,
only system administrators have this privilege.
Executing START on the remote computer will result in spawning detached
processes. These processes are not "connected" (that is, no input or output is
possible) and will not be killed when you exit the remote command shell. This
wastes resources on the remote computer.
The standard users environment is not set up in the remote command shell. Any
environment must be set up explicitly during the command session.

Remote Control
Remote Control overview
DameWare Remote Support has three Remote Control options in the Network Browser:
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l

Mini Remote Control

l

Mini Remote Control RDP

l

RDP View

Both of the Mini Remote Control options launch the DameWare Mini Remote Control
program (as a separate application passing command line parameters) for the system
highlighted in the Network Browser pane. If Mini Remote Control has this system in its
Saved Host List, the program uses those settings for the Mini Remote Control connection.
If the system is not in the Saved Host List, Mini Remote Control creates a new (temporary)
entry using the details in the Default Host Properties dialog in Mini Remote Control.
If you want Mini Remote Control to automatically connect to the remote system
when you launch Mini Remote Control from the Remote Support Network Browser,
ensure the Attempt to Connect setting is enabled on the Remote Control tab in
Remote Support's Properties dialog. If this setting is not enabled, the Mini Remote
Control program opens the Remote Connect dialog and displays the selected
system's Saved Host List entry if available. For additional information about the
Remote Control properties, see Remote Control tab.
For additional information about DameWare Mini Remote Control, see the Mini Remote
Control release notes.
The RDP View option opens an RDP viewer in the Remote Support application and
establishes a connection to the remote system using credentials and options you specify.
For additional information about this option, see RDP view.

RDP view
DameWare Remote Support's RDP view allows you to connect to remote system using an
RDP viewer in the Remote Support application. Use this view to connect to remote
systems running Terminal Services. All you need is network access, the correct TCP ports
open on any routers or firewalls between the local & remote systems, and the necessary
permissions to connect.
To make an RDP connection:

1. Open the RDP view.
2. If the RDP view does not automatically display the RDP Host Properties dialog, click
Connect in the RDP view mini toolbar.
3. Enter the hostname or IP address of the remote system.
4. Enter the User Name, Password, and Domain Name for the remote system.
5. Click OK.
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6. If Remote Desktop is not enabled on the remote system, Remote Support displays a
dialog asking if you want to enable it:
a. If applicable, select Disable Remote Desktop on Disconnect.
b. If you want to enable Remote Desktop on the remote system, click Yes.
Otherwise, click No.

Replication view
If you open the Replication view for a computer that does not support it, Remote
Support returns an error.
The DameWare Remote Support Replication view allows you to manage replication on
remote systems running older versions of Windows. You can manage both import and
export directories in one window interface. The Replication view displays the following
sortable columns in their respective panes:

Import Directory pane
l

Import Directory

l

State

l

Last Update

l

Lock Count

l

Lock Time

l

Exporter

Export Directory pane
l

Export Directory

l

Stabilize

l

Subtree

l

Lock Count

l

Lock Time

The Export Directory window pane will be enabled only for systems running a
server version.
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Windows replication overview
Directory replication is the copying of a master set of directories from a server (called an
export server) to specified servers or workstations (called import computers) in the same
or other domains. Replication simplifies the task of maintaining identical sets of
directories and files on multiple computers because only a single master copy of the
data must be maintained. Files are replicated when they are added to an exported
directory and every time a change is saved to the file.

Export server
To temporarily stop exporting a subdirectory, select the subdirectory and then click Add
lock to the selected directory in the Replication view mini toolbar. To resume
exporting a locked subdirectory, select the subdirectory and then click Remove lock
from the selected directory. To export a subdirectory and all of the subdirectories in
its' tree, select the subdirectory and then select Entire Subtree. Or, to export only the
highest subdirectory in a tree, select the subdirectory and then select Entire Subtree to
unselect. To specify a two-minute or longer delay during which no changes can be made
before files are exported, select a subdirectory and then select the Wait Until Stabilized
option. To export files immediately after they are changed, select a subdirectory and
then select Wait Until Stabilized option to unselect.
Notes:
l

l

l

l

l

l

Usually, you should only remove locks that you have applied. Exporting resumes
only when the Locks column shows a value of 0 for the subdirectory.
Select the Add Replication Entry option to add a subdirectory to the list. Select
Delete Replication option to remove the selected subdirectory from the list.
If it does not already exist, the system creates the share REPL$ which is required
for export replication. If it is not already running, the system starts the Directory
Replicator service.
Only Windows Server computers can be set up as replication export servers.
Make sure an appropriate logon account has been assigned to the Directory
Replicator service before performing this procedure.
The directories to be exported must be subdirectories of the replication From Path.
You can add the files to be exported to these subdirectories. However, this is
optional. Once you set up replication any files later added to these subdirectories
will be exported automatically. You can also later add additional subdirectories to
the From Path.
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l

By default, the To List contains no entries and this computer automatically exports
to the local domain. However, if you add any entries to the To List, the computer
will no longer automatically export to the local domain. To then export to the local
domain, the domain name must explicitly be added to the To List.

Import computer
To temporarily stop importing to a subdirectory, select the subdirectory and then click

Add lock to the selected directory in the Replication view mini toolbar. To resume
exporting a locked subdirectory, select the subdirectory and then click Remove lock
from the selected directory.
Notes:
l

l

Make sure an appropriate logon account has been assigned to the Directory
Replicator service before performing the procedure.
By default, the From List contains no entries and this computer automatically
imports from the local domain. However, if you add any entries to the From List the
computer will no longer automatically import from the local domain. To then
import from the local domain, the computer name must explicitly be added to the
From List.

Schedule
Job Schedule view
The DameWare Remote Support Job Schedule view allows you to manage the Job
Scheduler (or AT Scheduler) functionality on remote systems. Use Batch Processing to
schedule commands on one or more remote systems from the bottom of the Job
Schedule view. For additional information about Batch Processing, see Batch Processing.
The upper portion of the Job Scheduler view displays information about jobs scheduled
on remote systems in the following sortable columns:
l

ID

l

Week Day(s)

l

Month Day(s)

l

Time

l

Command

l

Interactive

l

Error

- 55 -

Remote System Tasks and Views
Use the mini toolbar at the bottom of the Job Scheduler view to add, delete, copy, or
modify jobs on remote systems.
To add a new job to a remote system:

1. Open the Job Schedule view for the remote system.
2. Click Add Schedule in the Schedule mini toolbar, or select Add Schedule from the
Schedule menu.
3. In the Command field on the Add New Schedule window, enter the command you
want to schedule.
4. In the This Occurs section, select one of the following options:
l

Today

l

Tomorrow

l

Every

l

Next

5. If applicable, select one or more days in the Week Day(s) section.
6. If applicable, select one or more days in the Month Day(s) section.
7. In the Time field, enter or select the time you want the job to occur.
8. Select or clear the Interactive option depending on whether you want to allow
user intervention when the job occurs.
9. Click OK.
View existing Scheduled Jobs in Remote Support's Job Schedule view or on the remote
system itself. To modify the properties of an existing job, click Schedule Properties on
the Schedule mini toolbar, or select Properties from the Schedule menu.

Task Schedule view
The DameWare Remote Support Task Schedule view allows you to manage the Task
Scheduler functionality on remote systems. Use Batch Processing to add or modify
scheduled tasks on one or more remote systems from the bottom of the Task Schedule
view. For additional information about Batch Processing, see Batch Processing.
The upper portion of the Job Scheduler view displays information about jobs scheduled
on remote systems in the following sortable columns:
l

Name

l

Schedule
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l

Next Run Time

l

Last Run Time

l

Status

l

Last Result

l

Creator

Use the mini toolbar at the bottom of the Job Scheduler view to add, delete, copy, or
modify tasks on remote systems.
To add a new task to a remote system:

1. Open the Task Schedule view for the remote system.
2. Click Add Schedule in the Schedule mini toolbar, or select Add Schedule from the
Schedule menu.
3. In the Task Schedule Name field on the Create New Task Schedule window, enter
a name for the new task.
4. Click OK.
5. On the New Task Properties window, complete the Task tab:
a. In the Run field, enter or browse to the path and filename of the program
you want to run, and add any switches/options as necessary.
b. If applicable, add comments in the Comments field.
c. In the Run as field, specify the user and password for the task.
d. Select or clear the Enabled option as applicable.
6. Complete the Schedule tab:
a. To add a schedule for the new task, click New .
b. In the Schedule Task menu, select the frequency for the new task.
c. In the Start time field, enter or select the time you want the task to run.
d. If applicable, set the appropriate options relative to the frequency you chose.
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7. Complete the Settings tab:
a. In the Scheduled Task Completed section, specify when you want the task
to stop or be deleted based on its run time and scheduling settings.
b. In the Idle Time section, specify the settings for running tasks when the
remote system is idle.
c. In the Power Management section, specify whether you want the task to
run when the remote system is running on batteries and/or wake up the
remote system to run the task.
8. Click OK.
View existing Scheduled Tasks in the Task Schedule view or on the remote system itself.
To modify the properties of an existing task, click Schedule Properties on the Schedule
mini toolbar, or select Properties from the Schedule menu.

Search view
The Search view allows you to search for a user account across domains, servers and
workstations. The search criteria can be filtered by What to Search, Where to Search, and
what types of systems to include in the search. To search a domain or system, add it to
the Where to Search list. DameWare Remote Support saves the list for easy access from a
later session. After the search is complete, Remote Support displays the results in the
lower portion of the window. If necessary, copy the results to your favorite word
processor, spreadsheet or file.
The following criteria are available in the Search view.
What To Search:
l

User accounts

l

Global Groups

l

Local Groups

l

Shares

Where to Search:
l

Servers and Workstations

l

Domains

Send Message view
The Send Message view is based on Microsoft's NetSend command and is limited
to its restrictions. Microsoft removed the Messenger Service and the NetSend
command in Windows Vista, Windows 2008, and Windows 7.
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The DameWare Remote Support Send Message view provides an easy way to send
messages to other users, computers or messaging names on the network. Use Batch
Processing to send messages to multiple individual systems, or broadcast messages
across workgroups and domains. For additional information about Batch Processing, see

Batch Processing.
Notes:
l

l

The Messenger service must be running to send or receive messages. You can
send a message only to a name that is active on the network. If the message is sent
to a username, that user must be logged on and running the Messenger service to
receive the message.
Some operating systems and service pack levels limit the number of characters
that a broadcast message can contain. The lowest cap is 117 characters, but caps
vary depending on OS and service pack.

Services
Services view
The Services view consists of two tabs, which display the remote system's services and
device drivers, respectively. Use the Services view to start, stop, pause, and continue
services. You can also modify a service's Startup Properties and view Service
Dependencies. DameWare Remote Support also provides an easy to use wizard interface
for both Service Installation and Service Removal. Batch Processing can be initiated from
one client machine to any machine available in the Network Browser. The Services view
allows the user to switch between the Services tab and the Device Drivers tab in the
upper portion of the view and displays the machines included in the Batch Processing in
the lower portion of the view. This lower portion of the Services view works like a queue
manager of the target machines. Machines can be added to the Batch Processing using
drag and drop from the Network Browser. The machines added to the Batch Processing
are saved so that each time you load the Services view the machines will be listed. Batch
Processing can be aborted at any time during the Batch process.
Use Batch Processing to make the following modifications to services on one or more
remote systems:
l

Start Service

l

Stop Service

l

Pause Service

l

Continue Service
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l

Remove Service This option will also allow for all dependent services to be stopped
when this service is removed.

l

Startup Type

l

Service Installation

l

Install DameWare Remote Support Service

l

Install DameWare Mini Remote Control Service

For additional information about Batch Processing, see Batch Processing.

Service Groups
DameWare Remote Support is Service Group aware. This means that as you stop a
service that is member of a service group, you are prompted with a list of all dependent
services and can choose whether you want to stop all services in the service group.
Service Group
A group of similar services that are loaded together at startup. Windows operating
systems load one service group at a time. After the OS loads all the service groups, it
loads all other services that are not part of a service group.

Install Service wizard
Use the Install Service wizard to install services on remote systems. The service
executable file can be located on the local or remote system. DameWare Remote Support
dynamically creates drive mappings for all drives on the remote system so the service
executable can be installed from the remote system's disk(s).
If the administrator is not authenticated to the remote machine, then he/she will
be prompted for credentials prior to the dynamic drive mappings.
To install a service on a remote system:

1. In the Browser Pane, select the remote system on which you want to install the
service.
2. From the Tools menu, select Service Installation.
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3. In the Service Installation window, complete the Service Names dialog:
a. In the Machine field, enter the hostname or IP address if necessary.
b. In the Service Name field, enter the name of the service. The Service Name
cannot contain forward or backward slash characters.
c. In the Service Display Name field, enter a display name for the service. The
Service Display Name is the text that appears in the Services view.
4. Click Next.
5. Complete the Service Executable dialog:
a. In the Service Executable File Location field, enter or browse to the
executable to install, including the full file path. When you click Browse,
Remote Support opens a Browse dialog in which you can browse both the
local and remote file systems.
b. If the executable is not on the remote system, select Copy Executable to
System32 Directory.
c. If you want to copy additional files to the remote system, click Add, and then
browse the local file system for additional files.
d. If you want to specify command line parameters for the service, click
Parameters, and then enter them.
6. Click Next.
7. On the Service Type dialog, select one of the following:
l

Service is it's own process

l

File system driver

l

Device driver

8. Click Next.
9. On the Service Logon dialog, select one of the following:
l

l

System Account: If applicable, also select Allow Service to Interact with
Desktop.
This Account: Click Browse to browse to the account you want to specify for
the service.

10. Click Next.

- 61 -

Remote System Tasks and Views

11. On the Service Startup Option dialog, select one of the following:
l

Automatic

l

Manual

l

Disabled

l

Boot

l

System

12. If applicable, select Start Service After Installation.
13. Click Next.
14. On the Finish dialog, review the details of the new service. If necessary, click Back
to return to an earlier dialog.
15. To start the installation, click Finish.

Remove Service wizard
Use the Remove Service wizard to remove services from remote systems. The service
executable file can be located on the local or remote system. This wizard allows you to
remove any service, including device drivers, from remote computers. If a service has any
dependencies, Remote Support allows you to specify whether or not you want to stop
those services.
Use extra caution when you remove device driver services.
To remove a service from a remote system:

1. In the Browser Pane, select the remote system on which you want to install the
service.
2. From the Tools menu, select Service Installation.
3. On the Machine Name dialog in the Service Removal window, enter the hostname
or IP address for the remote system if necessary.
4. Click Next.
5. On the Service Name dialog, select the service from the Service Name list. If you
want the wizard to include device drivers in the list, first select Include device
drivers.
6. Click Next.
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7. On the Finish dialog, review the details of the removal task. If necessary, click Back
to return to an earlier dialog.
8. To remove the service, click Finish.

Sessions view
Windows defines sessions as a link between two network devices such as a client and a
server. A session between a client and server consists of one or more connections from
the client to the server.
The DameWare Remote Support Sessions view displays the details of all open sessions of
the remote computer with the following sortable columns:
l

l

l

l

Client: Displays the client(s) currently connected to the remote system.
User Name: Displays the name of the client user that is connected to the remote
system.
Time: Displays the session connect time in HH:MM:SS.
Idle Time: Displays the idle time returned for the current session connection in
HH:MM:SS.

l

Opens: Displays the current number of opens that a session connection has.

l

Guest: Displays whether the connected user is a Guest on the remote system.

l

l

Transport: Displays the device used to make the connection to the remote system.
For example, a typical connection might be using the Network Interface Card
device running NetBIOS over TCP/IP and would look something like this:
\Device\NetBT_E190x1.
Type: Displays the session connect machine Operating System.

Use mini toolbar on the Sessions view to delete or view the properties of a selected
session, and/or connect to the remote system using Mini Remote Control.

Shares view
The DameWare Remote Support Shares view allows you to view, create, delete, and
modify shares on a remote system. Use the tree view on the left to browse files and
folders on the remote system.
Use the mini toolbar on the Shares view to perform any of the following tasks on the
remote system:
l

Add Share: Opens the Add Share dialog. Use the Browse option to dynamically
establish a mapping to the drive on the remote system and specify the drive/path
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to share.
The Share path must be a drive based path in reference to the system on
which you are creating the share.
l

l

l

l

Delete Share: Deletes the selected share. If a user is connected to the share,
Remote Support displays a warning that deleting the share might result in data
loss.
Share Sessions: Opens the Share Sessions dialog. This dialog displays the share
information along with a line entry for each user that has a session to this share.
The dialog displays the User, Computer, Connected Since, Idle Time, Open Files and
Guest fields related to each user session. Use this dialog to disconnect a user's
session to the share or retrieve file details related to a specific user session.
Share Properties: Opens the Share Properties dialog. Use this dialog to enable
or disable the share, modify the share comment, modify the user limit, and modify
the permissions associated with the share.
Set Default Shares: Creates the default administrative shares on the remote
system. These include the Administrator Share (ADMIN$), Drive Shares (such as C$,
D$) and Print Share (print$).

Additional Information
The following is a brief overview of shared resources.
Shared Resource
Any device, data or program that is used by more than one other device or program. For
Windows operating systems, shared resources refer to any resource that is made
available to network users, such as directories, files, printers and named pipes. Also
refers to a resource on a server that is available to network users.

Controlling Access to Files and Folders
On NTFS volumes, you can set permissions on files and folders that specify which groups
and users have access to them and what level of access is permitted. NTFS file and
folder permissions apply both to users working at the computer where the file is stored
and to users accessing the file over the network when the file is in a shared folder. With
NTFS, you can also set share permissions, which operate on shared folders in
combination with file and folder permissions.
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With FAT volumes, you cannot set permissions on the individual files and folders. The
only security you can set on FAT volumes is share permissions. Once a folder is shared,
you can protect the shared folder by specifying one set of share permissions that applies
to users for all files and subfolders of the shared folder. Share permissions are set in
very much the same way as file and folder permissions are set in NTFS. But because
share permissions apply globally to all files and folders in the share, they are
significantly less versatile than the file and folder permissions used for NTFS volumes.
Share permissions apply equally to NTFS and FAT volumes. The Windows operating
system, not the individual file system, enforces them.

Special Shares
A computer's shared resources include those resources (such as directories) that have
been shared by a user or an administrator plus any special shares that may have been
created by the system.
Depending on the configuration of the computer being administered, some or all of the
following special shares may appear when the Windows operating system presents a list
of the computer's shared resources. These shares are created by the system. In most
cases, these special shares should not be deleted or modified.
The following table describes some common special shares.
Driveletter$ Represents a share which allows administrative personnel to connect to
the root directory of a storage device. Shown as A$, B$, C$, D$ and so on.
For example, D$ is a share name by which drive D might be accessed by
an administrator over the network. For a Windows Workstation computer,
only members of the Administrators and Backup Operators can connect
to these shares. For a Windows Server computer, members of the Server
Operators group can also connect to these shares.
ADMIN$

Represents a resource used by the system during remote administration
of a computer. The path of this resource is always the path to the
Windows operating system root (That is, the directory in which the
operating system is installed. For example: C:\Winnt). For a Windows
Workstation computer, only members of the Administrators and Backup
Operators can connect to this share. For a Windows Server computer,
members of the Server Operators group can also connect to this share.

IPC$

Represents a resource sharing the named pipes that are essential for
communication between programs. Used during remote administration
of a computer and when viewing a computer's shared resources.

PRINT$

Represents a resource used during remote administration of printers.
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REPL$

A resource created by the system when a Windows Server computer is
configured as a replication export server. It is required for export
replication. This resource is only provided for Windows Server
computers, which are configured as replication export servers. It is not
provided for Windows Workstation computers.

NETLOGON

A resource used by the Net Logon service of a Windows Server computer
while processing domain logon requests. This resource is only provided
for Windows Server computers. It is not provided for Windows
Workstation computers.

Shared Directory Permissions
You can set the following permissions for files and directories through a shared
directory:
l

l

l

l

No Access (None): Prevents access to the shared directory, its' subdirectories and
its' files.
Read: Allows viewing filenames and subdirectory names, changing to the
subdirectories of the shared directory, viewing data in files and running
application files.
Change: Allows viewing filenames and subdirectory names, changing to the
subdirectories of the shared directory, viewing data in files, running application
files, adding files and subdirectories to the shared directory, changing data in files
and deleting subdirectories and files.
Full Control: Allows viewing filenames and subdirectory names, changing to the
subdirectories of the shared directory, viewing data in files, running application
files, adding files and subdirectories to the shared directory, changing data in files,
deleting subdirectories and files, changing permissions (NTFS files and directories
only) and taking ownership (NTFS files and directories only).

Shutdown view
The DameWare Remote Support Shutdown view allows you to shut down, power off, or
log users off of any remote system. The Shutdown view displays the real time status,
logged on user(s), and any applications that are running for the remote system. Use
Batch Processing to perform any of the Shutdown functions on one or more remote
systems from the lower pane of the Shutdown view. For additional information about
Batch Processing, see Batch Processing.
In addition to Batch Processing, the Shutdown view supports the following actions in the
mini toolbar:
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l

Shutdown: Opens the System Shutdown dialog for the remote system.

l

Logoff: Opens the User Logoff dialog for the remote system.

l

Power Off: Opens the Power Off dialog for the remote system.

When you launch one of these commands from the Shutdown view mini toolbar, the
corresponding dialog presents the following options unless otherwise noted. When you
launch Batch Processing for one or more remote systems from the Shutdown view, the

Batch Logoff / Power Off / Shutdown window displays these options on separate tabs
for each command:
l

l

l

l

l

l

Reboot after Shutdown: Shutdown only. It instructs the routine whether to reboot
the target machine after the shutdown command is executed.
Force Application Termination: When selected specifies whether to force
applications running on the target machine(s) to be closed before the shutdown of
the target machine.
Time to Shutdown Countdown: Specifies the delay in seconds before the Batch
process is actually initiated.
Allow User to Abort: Logoff and Power Off only. Will present a dialog box on the
target machine where the user can Abort the process.
Install Service if not Installed: Logoff and Power Off only. Dynamically installs the
DameWare Remote Support service on the target machine allowing the process to
be completed.
Message Text: The message text is presented in a dialog window to the target
machine(s). The maximum number of characters allowed is 117 for Shutdown and
255 for Logoff and Power Off.

Notes:
l

l

When the system specified to receive the Logoff command is running the Windows
Active Desktop, the command closes the desktop, but may not close the user
connections.
When the system specified to receive the Power Off command does not support
Power Off features, the command reboots the system. The Power Off feature is
only supported on hardware that supports auto-power off.

l

DameWare Remote Support does not support the Shutdown process against
Windows 9x clients.

- 67 -

Remote System Tasks and Views

Installed Software view
The DameWare Remote Support Installed Software view allows administrators to see
installed software and its properties on remote systems. When you open the Installed
Software Properties window from the Installed Software view, Remote Support displays
all available properties for the selected program, and provides Up and Down buttons so
you can browse the properties of all installed software easily.
The Installed Software view displays details for each program in the following sortable
columns:
l

Application (name)

l

Version

l

Registered Owner

l

Registered Company

System Tools view
The DameWare Remote Support System Tools option from the Network Browser expands
to a maximum of sixteen user-defined tools. Add or remote system tools on the System
Tools tab of the DameWare Remote Support Properties window. Remote Support
dynamically reflects your changes in the Network Browser. These system tools are stored
on the system running DameWare Remote Support, so they are the same for any system
you select. The System Tools in DameWare Remote Support support the following
macros:
l

%Machine%

l

%Domain%

l

%IP% (IP address)

The default items in Remote Support's System Tools menu are samples to illustrate how
you can run third party applications from within Remote Support's interface. These
third party applications have nothing to do with Remote Support and they are not part
of the Remote Support program. For example, the default system tool, Registry Editor
(Sample) opens regedit.exe from %SystemRoot% on the remote system. The following
procedure illustrates adding Microsoft's built-in calculator application to the System
Tools list.
To add a new tool to the system tools list:

1. Open DameWare Remote Support.
2. Click System Tools on the menu bar, and then select Edit System Tools.
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3. On the System Tools tab of the DameWare Remote Support Properties window,
click

.

4. Enter a name for the new tool. For example, enter Calculator.
5. With the new tool selected in the Menu Contents pane, enter the path for the
program in the Command field. For the calculator application, enter
%windir%\system32\calc.exe.
6. If applicable, enter any command-line arguments in the Arguments field. For
example, enter \\%Machine%.
7. In the Initial Directory field, enter the starting directory for the application. For
example, enter %HOMEDRIVE%%HOMEPATH%.
8. Click OK.
Remote Support adds the new tool to the System Tools list. When you run the new tool
for a specific system, Remote Support opens the application for that system if it can.
Some applications (like calc.exe) do not support parameters such as %Machine%.
If that is the case, Remote Support opens the tool on the local system.
For additional information about the options on the System Tools tab, see System Tools
tab.

TCP Utilities view
The TCP/IP utilities in this view provide diagnostic and connectivity tools for connecting
to other systems, network administration and troubleshooting. The DameWare Remote
Support TCP Utilities view is a single window view from which you can execute all of the
available utilities. Remote Support displays the following utilities on their own tabs
within the TCP Utilities view.

DNS Lookup tab
This diagnostic tool displays information from Domain Name System (DNS) name servers.
Before using this tool you should be familiar with how DNS works. The DNS Lookup tab
provides the following DNS Record Type options:
l

l

A: The address (A) resource record maps a host (computer or other network device)
name to an IP address in a DNS zone.
NS: The name server (NS) resource record identifies the DNS server or servers for
the DNS domain. NS resource records appear in all DNS zones and reverse zones
(those in the in-addr.arpa DNS domain).
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l

CNAME: The host name portion of a URL may actually be an alias and is also
referred to as a canonical name (CNAME). We can break down the address,
http://www.microsoft.com, like so:
l

www is an alias commonly used for World Wide Web servers.

l

Microsoft is the domain name.

l

.com indicates the commercial branch of the DNS hierarchy of names for
the Internet.

DNS uses the CNAME resource record to establish an alias name in DNS server
zone files. CNAMEs are frequently used in conjunction with Web, FTP and Gopher
servers and when a host name is changed. The use of CNAMEs is accepted on the
Internet for generalized names for servers such as www to indicate a Web server.
However, other uses of the CNAME records can create problems for DNS name
resolution throughout the Internet. RFC 1912, which describes common errors in
the creation of DNS resource records, states: "Don't use CNAMEs in combination
with RRs [resource records] which point to other names like MX, CNAME, PTR and
NS."
l

MX: The mail exchanger (MX) record specifies the mail server for a recipient's
domain.

Ping tab
This diagnostic tool verifies connections to a remote computer or computers. This
command is available only if the TCP/IP protocol has been installed. Remote Support also
displays the Ping option in the Network Browser under TCP Utilites.

Trace Route tab
This diagnostic utility determines the route taken to a destination by sending Internet
Control Message Protocol (ICMP) echo packets with varying Time-To-Live (TTL) values to
the destination. Each router along the path is required to decrement the TTL on a packet
by at least 1 before forwarding it so the TTL is effectively a hop count. When the TTL on a
packet reaches 0, the router is supposed to send back an ICMP Time Exceeded message to
the source system. Trace Route determines the route by sending the first echo packet
with a TTL of 1, and then incrementing the TTL by 1 on each subsequent transmission
until the target responds or the maximum TTL is reached. The route is determined by
examining the ICMP Time Exceeded messages sent back by intermediate routers.
Some routers silently drop packets with expired TTLs and will be invisible to Trace
Route.

MX Test tab
This diagnostic tool performs a lookup for the MX (mail exchange) resource record for the
specified domain.
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Resolve tab
This diagnostic tool resolves the hostname or IP you enter into the Machine/IP Address
field to the corresponding hostname and IP address.

Terminal Server view
The DameWare Remote Support Terminal Server option from the Network Browser
expands with three options:
l

l

Terminal Server View: Provides complete functionality to manage the
administration of Windows Terminal Server users, sessions, processes and other
information including Terminal Server Shutdown.
Terminal Server Client: Launchs a user session to the Windows Terminal Server
selected in the Network Browser window.
The Terminal Server Client must be installed on the local system prior to
launching a user session. When executed, Remote Support attempts to run
the client installation program if the client is not installed.

l

Mini Remote Control RDP: Opens the RDP view in the Remote Support
application.

The Terminal Server View displays two panes. The left pane displays a list of servers and
sessions. The right pane contains several tabs that display information about the
Windows Terminal Server and/or sessions selected in the left pane. The available tabs
and columns vary depending on whether you select a Windows Terminal Server or a
specific session:

Users tab
l

User

l

Sessions

l

ID

l

State

l

Logon Time

l

Last Logoff

Sessions tab
l

Session

l

User

l

ID
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l

State

l

Client Name

l

Logon Time

l

Last Logoff

Processes tab
l

User

l

Session

l

ID

l

PID

l

Image

Information tab
Build

Installation Date

Service Pack level

Hotfix

Installed By

Installed On

Description

Comments

User Name

Client Name

Client Build Number

Client Directory

Client Product ID

Client Hardware ID

Client Address

Client Color Depth

Client Resolution

Users view
The DameWare Remote Support Users view allows administrators to create and manage
users on remote systems, along with multi-select copy, delete, and rename functions.
The following sections describe related groups of user functions in this view.

View and Organize Users
Use the Users view to view and organize users, including:
l

View Microsoft Exchange and Windows Terminal Server User properties.

l

Copy users to remote systems and domains.

l

Drag and drop users to add to or removing from groups.

When you use the Copy User option, you may select to set the password to the
same as the UserID, leave the password blank, or specify a new password.
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Create and Edit Users
Use the Users view to create or edit users on remote systems. If you choose to create
multiple users at the same time, the User Properties window provides the following
configurable options:
l

Name and password schema(s)

l

Group membership

l

User profile information including logon script names and home directory options

l

Hours during the day that the user(s) is/are allowed logon access

l

Remote Access Administration options including call back and dial in permissions

l

Account expiration and account type

l

Workstation log in privileges

The User Properties Window
The User Properties window consists of the following tabbed dialogs.
l

l

l

User: Manage user property information like name, comments and password here.
This is also where password expiration and account-disabled properties can be
set. The password Age and password Last Changed date are displayed in the lower
right hand portion of this dialog.
Group: User group membership and primary group properties can be set.
Profile*: User profile paths, login script and home directory properties can be set
in this option. Terminal Server Home Directory properties can also be set here.

l

Configuration*: User options for Windows Terminal Server

l

Dialin: User dial in privileges are set in this option as well as call back options.

*Only available server(s) running Windows Terminal Server.

Supported macros
l

%USERNAME%

l

%USERFULLNAME%

When adding multiple new users you can specify ANSI or UNIX sprintf functions for
format specifications. For example, change TestUser%d to TestUser%03d to create user
accounts such as TestUser001, TestUser002, and so on.

Creating users' home directories
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The following examples illustrate how to create users' home directories using macros.
Drive E: serves as the hypothetical destination for the home directory on the user's
system.
l

l

l

Map E: to \\server\users\%USERNAME% if the folder 'r;users' already exists on the
server and is shared.
Map E: to \\server\c$\%USERNAME% to create the folder to the c:\root drive on the
server, such as c:\jdoe.
Map E: to \\server\c$\users\%USERNAME% to create the folder on the server's c:
drive, as in c:\users\jdoe. This also assumes the folder 'r;users' already exists.

Manage User Policies
Use the Users view to manage user account security settings, such as Account Policy,
User Rights, and Audit Policy. To modify these settings, select a user from the Users list,
and then click the corresponding button on the Users view mini toolbar.

Additional Information
The following is a brief summary of the Windows Vista/2008/Windows7 Security policies.
Account Policy

The Account Policy controls how passwords must be used by all user accounts. It defines
things such as the maximum password age, minimum password age, minimum
password length, whether a password history is maintained and whether users must log
on before changing their passwords. It also determines lockouts. If locking out is
enabled, then a user account cannot log on after a number of failed attempts to log on to
that account within a specified time limit between failed attempts. Lockout can also
occur from attempting to change the password using an incorrect password for the old
password. A locked account remains locked until an administrator unlocks it or a
specified amount of time passes. The Account Policy also determines whether or not a
remote user is forcibly disconnected from a domain when that user's logon hours expire.
Failed password attempts against workstations or member servers that have been
locked using Ctrl+Alt+Delete or password protected screen savers, do not count
against account lockout settings entered in User Manager for Domains.
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User Rights Policy

The User Rights Policy manages the rights granted to groups and user accounts. A right
authorizes a user to perform certain actions on the system. A user who logs on to an
account to which the appropriate right have been granted can carry out the
corresponding actions. When a user does not have appropriate rights, attempts to carry
out those actions are blocked by the system. User rights apply to the system as a whole
and are different from permissions, which apply to specific objects. The rights granted to
a group are provided to the members of that group. In most situations, the easiest way to
provide rights to a user is to add that user's account to one of the built-in groups that
already possesses the needed rights rather than by administering the User Rights Policy.
The DameWare Remote Support User Rights window view will allow selection to show the
Standard User Rights, Advanced User Rights or All User Rights. Once selected, the value
will be saved when the User Rights window view is entered again.
Audit Policy

You can track selected user activities by auditing security events and storing the data in
a security log. Your Audit Policy specifies the types of security events to be logged. These
types can range from system-wide events (such as a user logging on) to specific events
(such as a user attempting to read a particular file). They can include successful events,
unsuccessful events or both. When you administer domains, the Audit Policy affects the
security logs of all domain controllers. When you administer a computer that is not a
domain controller, the Audit Policy affects the security log of only that computer. Use
Event Viewer to review events in the security log on the local system.

Wake on LAN view
The DameWare Remote Support Wake on LAN view has two separate panes. The upper
pane displays information about the systems to awaken. The lower pane displays the
ping results (optional) of a batch wake up call.
To request a Batch wake up call:

1. Select one or more systems in the upper pane. Hold Ctrl or Shift to select multiple
systems.
2. Click Wake On LAN in the menu bar, and then select Wake Batch.
3. If you want to see the results of the wake up call in the lower pane of the Wake on
LAN view, select Ping after wake.
4. If applicable, specify the Port and Number of packets for the wake up call.
5. Click OK.
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Wake on LAN requires knowledge of the remote system's Media Access Control
(MAC) address. To compile a list of MAC addresses use the Discover function in
the Wake on LAN view, which discovers the local subnet addresses. This function
does not distinguish printers and routers from workstations. Since any host
beyond the local area does not appear in the local system's Address Resolution
Protocol (ARP) cache, the Discover function only creates a list of hosts in a local
network.
To aid in discovering other subnets, you utilize the console application, DWMacDis.exe,
which is located in the installation folder of Remote Support. You can either physically
visit each subnet to discover the MAC addresses or you can use Remote Support's
Remote Command or Remote Control applications: Copy DWMacDis.exe to a system on
the specific subnet, and then remotely run the application. Copy the output file back to
the local system.
This utility generates file in the following format.
#IP ADDRESS

HOST NAME

ETHERNET ADDRESS

139.95.26.1

domainname.domain.com

08-00-20-73-43-4f

139.95.26.8

cc1.domain.com

00-80-5f-88-56-0a

The default extension for the list file is .dwmp.
This utility uses the IP Broadcast Address to send a Magic Packet to one host on
the network. The default destination IP Broadcast Address is 255.255.255.255. This
is the 'r;limited broadcast' and the user may have to indicate a more specific
broadcast address. For example, specify 192.192.110.255 to reach all systems on
the 192.192.110.x subnet. The utility shows a default Ethernet address to illustrate
the format of the address. For the program to correctly generate a Magic Packet,
you must specify the Ethernet address.
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Application Properties
General tab
The General tab provides the following customization options:
Some properties require you to restart Remote Support after you change them.
Remote Support displays a dialog if it requires a restart.
l

l

l

l

l

l

l

Save Window Position: Clear this option if you want Remote Support to forget the
window position last used by the application.
Show Date and Time: Clear this option if you do not want Remote Support to
display the host system's time in the lower right corner of the application.
Add Icon to System Tray: Adds an Remote Support icon to the Windows system
tray.
Minimize to System Tray: Select this option if you want Remote Support to
minimize to the system tray instead of the Windows taskbar.
Limit to one Instance: Limits the Remote Support host system to only one open
instance of the application at a time.
Don't show Central Server Login Dialog: Enables or disables auto login to the
Central Server.
Close all connections on exit: Disconnects the Remote Support system from any
remote systems when you close the application.
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l

l

Close any current connections to the remote machine: Closes current
connections on the remote system when you connect with Remote Support.
Remember Security Credentials: Click Reset to remove all saved logon
credentials.

l

Display Grid: Displays a grid around all fields in the view.

l

Full Row Select: Enables highlighting of the entire row selected.

l

Hot-Track Selection: Enables a mouse-over highlight on the field.

l

l

One Click Activate: Enables a mouse-over highlight on the field and executes the
properties for the selected field.
Underline Hot-Track: Underlines the field(s) selected.
This option can only be used in conjunction with the One Click Activate.

l

Use Tabbed MDI Frame: Clear this option if you want Remote Support to display
the remote system views in stand-alone windows within the application.

To revert all settings on this tab to the default settings, click Reset All.

Network Browser tab
The Network Browser tab provides the following customization options:
l

l

l

l

l

l

l

Disable Microsoft Windows Network Support: Disables "old-style" NetBios
Windows Network functionality in Remote Support.
Expand Network Root: Shows all of the domains in the network when DameWare
Remote Support is loaded.
Tool Tips: Displays tool tips in the browser pane and tree views.
Expand Favorites Root: Shows all Domains listed in the Favorite Domains root
when DameWare Remote Support is loaded.
Show Computer Comments: Shows the Comments (Computer Description)
information obtained from the remote system behind the HostName / IP-Address
in Remote Support's Tree View.
Expand Favorite Machines Root: Shows all systems in the Favorite Machines root
when DameWare Remote Support is loaded.
Convert IP-Addresses: Displays the HostName of the remote system instead of
the IP address in Remote Support's Tree View.

- 78 -

Application Properties

l

l

l

l

l

Expand by Default: Select either the Member Domain or the Logon Domain to
automatically be expanded when Remote Support is loaded.
Use Any DC (directly trusted): Instructs Remote Support to use any domain
controller (DC) to enumerate the network instead of just a primary domain
controller (PDC).
Use alternate machines for PDC lookup failure: Click Alternate to specify
alternate domain controllers for Remote Support to use if it cannot enumerate the
network using the PDC.
Use this Machine for Domain/Machine Enumeration: Specify a system
anywhere on the network to use to retrieve the list of systems in the Microsoft
Windows Network browser.
Update Favorite Machines Icons: Automatically attempts to enumerate (contact)
each system in your Favorite Machines list to obtain information about the system
(operating system, version, tool tips, and so on).
l

l

Allow Logon on Anonymous Failure: Remote Support attempts to contact
remote systems by asking the operating system (OS) to make a "null"
connection to the remote system. However, some OS configuration and policy
settings do not allow this type of connection. If selected, this option instructs
Remote Support to look for saved credentials for remote systems when this
happens, and then attempt the connection again using those saved
credentials.
Enable Optional Ping: Remote Support attempts to contact remote systems
using "old-style" network API calls. If something blocks Remote Support from
contacting a remote system (port restrictions or firewalls, for example), then
that network thread must time out before Remote Support continues to
contact other systems. However, if you enabled this setting, Remote Support
sends a ping (ICMP Echo) to the remote systems first. If the ping fails, then
Remote Support will does not enumerate the failed system. Therefore,
Remote Support does not have to wait for any type of network timeout from
systems it cannot contact before moving to the next system.

TCP/IP tab
Use this tab to specify the font for the TCP and IP utilities views.

Event Log tab
The Event Log tab provides the following customization options:
l

Monitor Log (Local Machine Only): Instructs Remote Support to dynamically
update the selected event log on the local system in real time.
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l

l

Maximum Entries to Read: Specify the maximum number of Event Log entries to
read. This is especially advantageous in low bandwidth connection environments
where the administrator may only be interested in the last few entries in the Event
Log list. By setting a limit at this point, the administrator would not have to wait for
all events to be read and displayed in the Event Log window view.
Use local Event Log library to improve speed: Collects only Event IDs from
remote systems.
This option is only viable when the Remote Support system and remote
system(s) are running the same Windows operating system.

Active Directory tab
The Active Directory tab provides the following customization options:
Some properties require you to restart Remote Support after you change them.
Remote Support displays a dialog if it requires a restart.
l

Disable Active Directory Support: Remotes the Active Directory node from the
Network Browser pane.

l

Cache Results

l

View Advanced Features: Enables Active Directory Advanced Features.
Changes made to this feature require a refresh before they will take effect.

l

Add computer options for site root: Enables DameWare Remote Support
Windows Views (Disk Drives, Event Log, and so on) within Remote Support's Active
Directory site root.
Changes made to this feature require a refresh before they will take effect.

l

Use DNS entry for Computers
l

l

Enable Computer Options in Views: Adds the "Computer" menu option to the
right-click shell context menu for systems listed under the Active Directory node in
the Network Browser pane.
l

l

Auto append if no entry

Update Computer information in views

Choose Columns: Customize which columns are visible within Remote Support's
Active Directory object views.
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l

Expand AD Root: Automatically expands the Active Directory node in the Network
Browser pane when Remote Support is launched.
Changes made to this feature and its children require a refresh before they
will take effect.
l

l

l

l

l

l

Expand this AD Site: Automatically expands the selected Active Directory
Site.
Expand Active Directory Computers: Automatically expands the Active
Directory Computers folder when DameWare Remote Support is launched.
Expand Active Directory Quick OUs: Automatically expands the Active
Directory Quick OUs folder when DameWare Remote Support is launched.
Expand Active Directory Users & Computers: Automatically expands the
Active Directory Users & Computers folder when DameWare Remote Support
is launched.
Maximum number of items displayed per folder (zero=no limit): Allows
you to filter how many records will be displayed in Remote Support's Active
Directory Object Views.

Create AD User Home Directory: Automatically creates the selected user's Home
Directory.
This option does not set Permissions on the Home Directory.

l

Set AD User Directory Security: Sets the security permissions for the selected
user's Home Directory.

Disk Drives tab
The Disk Drives tab provides the following customization options:
l

Create Temporary Share When No Administration Share is available

l

Use Drive mapping for menu access versus UNC path

Remote Control tab
The Remote Control tab provides the following customization options:
l

Attempt to Connect: When you select either of the Mini Remote Control
commands from the Network Browser pane, Remote Support launches the Mini
Remote Control program and automatically passes the hostname or IP address of
the selected system as a parameter. Select this option to instruct Mini Remote
Control to automatically attempt to connect to the remote system using stored
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credentials.
l

l

l

Connect only if found in Host List: Only connects automatically if the
remote system already has an entry in Mini Remote Control's Saved Host List.
If no entry is found, then Mini Remote Control opens the Remote Connect
dialog with the (temporary) entry that was created for the host.

Reuse any Mini Remote Control window that is not busy: Instead of opening
another a new instance of the Mini Remote Control program each time it is
launched from Remote Support, this setting attempts to use any existing window
(not currently at a prompt or dialog) first. If it cannot use an existing window, it
opens a new instance.
RDP Settings: Configure default RDP settings to use for RDP connections (instead
of an Mini Remote Control connections) to remote systems.

Threads tab
Many of the DameWare Remote Support functions are multi-threaded. Use this tab to
configure the thread priority for individual threads.
The Threads tab includes the following priority options, listed from fastest to slowest:
l

Time Critical

l

Highest

l

Above Normal

l

Normal

l

Below Normal (default)

l

Lowest

l

Idle

System Tools tab
Use the System Tools tab to add, remove, and manage third-party utilities you want to
be able to launch from within the Remote Support application. The System Tools tab
includes the following buttons at the top of the tab to manage the list of tools:
Create a New menu option.
Edit an existing menu option.
Move a menu option down.
Move a menu option up.
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Delete a menu option.
The default list of tools is comprised of a group of sample applications to illustrate
the functionality of this feature. None of these applications are affiliated with the
Remote Support program.
When you add or edit a menu option, configure the following settings as appropriate:
l

l

l

Command: Enter or browse to the application you want Remote Support to open.
Arguments: Enter any command-line arguments you want Remote Support to use
with the selected command.
Initial Directory: Enter or browse to the starting directory for the selected
command.

To add a separator to your menu list:

1. Create a new menu option.
2. Name the menu option Separator.
3. Click OK or Apply as appropriate.
To specify a control key for a menu item:

1. Create a new menu option.
2. Enter a name for the menu option with the ampersand (&) before the control key.
For example, &Performance Monitor results in the Performance Monitor menu
option with the command key, P.
3. Specify the option's settings.
4. Click OK or Apply as appropriate.

Users tab
The Users tab provides the following customization options:
l

Create User 'Profile Path' Directory If Specified and/or Changed:
Automatically creates the user's "profile path" directory (if specified).
This does not create any permissions on that directory.

l

Create User Home Directory If Specified and/or Changed: Automatically
creates the selected user's Home Directory.
This option does not set Permissions on the Home Directory.
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l

Set User Directory Security When Directory is Created and/or Changed (Full
Control for the specified user only): Sets the security permissions for the
selected user's Home Directory to "Full Control" for the selected user only.

Shutdown tab
The Shutdown tab provides the following customization options:
l

l

Refresh Delay: Specify the interval at which Remote Support should refresh the
information displayed in the Shutdown view.
Font: Specify the font for the Shutdown view.

Remote CMD tab
The Remote CMD tab provides the following customization options:
l

History List: Specify the number of commands Remote Support should remember
in the history list. The default is 100.

l

Back Color: Specify the background color for the Remote CMD view.

l

Font: Specify the font for the Remote CMD view.

RAS tab
Use this tab to specify the refresh delay, in seconds, for Remote Access Server.
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Network Overview & Troubleshooting
Pass-through authentication
DameWare Remote Support uses the pass-through authentication functionality built into
Windows operating systems (OS) to perform certain tasks without prompting for
credentials. Similarly, DameWare Mini Remote Control allows you to install the Mini
Remote Control Client Agent Service on a remote system using non-administrator
credentials in the Remote Connect dialog.
To perform these tasks, the OS attempts to pass your current local desktop credentials to
the remote systems. If the current credentials do not have sufficient rights to perform
the task, then the OS prompts you for a set of credentials that have the necessary rights.
After the program has authenticated to the remote system, the OS uses the same
credentials for tasks that require the same level of authentication.
If you establish a connection with a remote system using non-administrator credentials,
and then you try to perform a task that requires administrative rights, the program
returns an error stating that the user does not have sufficient permissions to execute the
task. If this happens, use the Disconnect Network Connections feature in Remote
Support to disconnect that connection and establish a new one with the appropriate
credentials.

Pass-through authentication and DameWare Mini Remote Control
When first attempting to contact a remote system, Mini Remote Control attempts a TCP
connection using the credentials specified in the Remote Connect dialog. If the Mini
Remote Control Client Agent Service is not installed on the remote system or is not
listening on the specified port, then the Mini Remote Control program drops out of TCP
mode and uses the installed protocols of the operating system to interrogate the remote
system.
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At this point, the connection to the remote system has nothing to do with the credentials
you supplied in the Remote Connect dialog. Mini Remote Control begins using passthrough authentication. If your current credentials do not have sufficient rights, then the
program prompts you to supply a set of credentials that has the necessary rights to
complete the task. Administrative rights are required to start, stop, install, or remove the
Mini Remote Control Client Agent Service. After Mini Remote Control verifies the Mini
Remote Control Client Agent Service is running on the specified TCP port, the program
attempts its TCP connection to the remote machine again, using the credentials specified
in the Remote Connect dialog box.

Common Errors
System Error 5 (Access Denied)
This error indicates you are using invalid credentials to access a remote system. Both
Remote Support and Mini Remote Control rely on the operating system's built-in security
and require administrator rights to install, remove, start, or stop any service in Windows.
For additional information, see Pass-through authentication.

System Error 1073
You get the following error when you try to install the Mini Remote Control Client Agent
Service on a remote system.
System Message: Failed to create service Error 1073
This message implies that the specified service already exists on the remote system.
To troubleshoot this issue:

1. Open the Services applet on the remote system.
2. Open the properties for the DameWare Mini Remote Control service.
3. On the General tab, ensure the Startup type is set to Automatic .
4. On the Log On tab, ensure the service is Enabled for the specific Hardware Profile.
If that does not work, reboot the remote system.

System Error 1219
System Message: The credentials supplied conflict with an existing set of
credentials.
This is not an error directly related to DameWare software and it can be duplicated in
other contexts. The most common reason for this error is that you already have a
connection to the remote system using a different set of credentials.
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Troubleshooting
To begin troubleshooting, click Disconnect Network Connections in the main Remote
Support toolbar to both display all connections, and then disconnect any connection(s) to
the system generating the error. After you disconnect the connection(s), try to re-connect
to the system with credentials that have adequate rights to do the job.
If that does not work, or there are not open connections with the remote system, reboot
the local system.
Finally, if these two steps fail, make sure you do not have a duplicate user ID on the
source and destination systems that utilize a different password. In this case, change the
passwords so they are identical on both systems, or change the user IDs so they are
different.
For additional information about this error, see this Microsoft KB article.

System Error 1326
There are no settings in the DameWare software that either cause or prevent a 1326
error. This error is generated by the operating system (OS). The error occurs when a
DameWare product asks the OS on your local system to execute standard Microsoft
Windows API calls to connect to a remote system.
If you see this error in Remote Support, you will also see it if you try to map a drive to the
admin$ share on the remote system from outside of Remote Support.

Troubleshooting
If the remote system is running Windows XP, make sure that "Simple File Sharing" is
disabled. Simple File Sharing only exists within Windows XP, and should not be confused
with File & Printer Sharing which exists in all Operating Systems.
To disable Simple File Sharing in Windows XP Professional:

1. Open My Computer.
2. Select Tools > Folder Options.
3. Click the View tab.
4. Disable Use simple file sharing (Recommended).
Another option is to adjust the "ForceGuest" policy setting on the remote system to make
sure all users authenticating to it over the network are actually authenticating as
themselves, and not as the Guest account.
To fix this policy in the Local Security Policy of the remote system:

1. Open Control Panel > Administrative Tools > Local Security Policy.
2. In the left pane, select Security Options.
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3. In the right pane, select Network access: Sharing and security model for local
accounts, and then click Action > Properties.
4. Select Classic – local users authenticate as themselves.
5. Click OK.

System Error 1327
If you attempt to use a blank password to connect to a remote system, you see the
following error in the Application Event Log on the remote system.
ERROR_ACCOUNT_RESTRICTION
Logon failure: user account restriction. Possible reasons are blank passwords not
allowed, logon hour restrictions, or a policy restriction has been enforced.
To resolve this issue:
Create a password for that user ID, or use a different user ID that has a password
assigned.
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